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ABOUT THE GUIDE

This section provides a brief description of the scope, the audience, the references, concepts and the
organization of the user guide and conventions incorporated into the user guide. The topics in this section
are organized as follows:

¢ Scope of the guide

¢+ Intended Audience

¢ Documentation Accessibility

¢ Related Information Sources

¢ How This Guide is Organized

¢ Conventions Used

ScoPE OF THE GUIDE

The objective of this user guide is to provide a comprehensive working knowledge on Oracle Financial
Services Regulatory Reporting for European Banking Authority (EBA) — Lombard Risk Integration Pack,
Release 8.0.5.0.0. This user guide is intended to help you understand the key features and functionalities
of Oracle Financial Services Regulatory Reporting for European Banking Authority (OFS REG REP EBA)
— Lombard Risk Integration Pack release 8.0.5.0.0 and details the process flow and methodologies used.

INTENDED AUDIENCE

Welcome to Release 8.0.5.0.0 of the Oracle Financial Services Regulatory Reporting for European
Banking Authority (EBA) — Lombard Risk Integration Pack User Guide.
This guide is intended for:

¢+ Regulatory Reporting Analyst who bears the responsibility to verify and submit the results.
He/She is also entrusted to maintain the dimensional values across multiple reporting
requirements, maintain results area structure of Oracle Financial Services Data Foundation.

+ Data Analysts, who clean, validate, and import data into the Oracle Financial Services Download
Specification format, and ensure that data is populated in the relevant tables as per the
specifications and executions required for regulatory reporting.

¢ System Administrator (SA), instrumental in making the application secure and operational and
configures the user roles providing necessary access to users.

DOCUMENTATION ACCESSIBILITY

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website
at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc
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ACCESS TO ORACLE SUPPORT

Oracle customers have access to electronic support through My Oracle Support. For information, visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

RELATED INFORMATION SOURCES

In addition to this user guide you can refer to the following documents in the OTN documentation library:

¢ Oracle Financial Services Regulatory Reporting for European Banking Authority (EBA) -
Lombard Risk Integration Pack Installation Manual Release 8.0.5.0.0

¢+ Oracle Financial Services Data Foundation User Guide Release 8.0.5.0.0
¢+ Oracle Financial Services Data Foundation Installation Manual Release 8.0.5.0.0

¢ Oracle Financial Services Analytical Applications Infrastructure User Guide Release 8.0.5.0.0
(present in the OHC documentation library)

How THIS GUIDE IS ORGANIZED

The OFS REG REP EBA User Guide includes the following topics:

¢ Chapter 1: Introduction

¢ Chapter 2: Getting Started

¢ Chapter 3: Regulatory Reporting Solution Data Flow
¢ Chapter 4: OFSAA Features

¢ Chapter 5: Report Submission

¢ Chapter 6: Maintenance

¢ Chapter 7: Troubleshooting Guidelines

CONVENTIONS USED

Table 1 lists the conventions used in this guide.

Table 1: Conventions Used in this Guide

Convention | Meaning

Italics Names of books, chapters, and sections as references
Bold ¢ Object of an action (menu names, field names, options, button names) in a step-by-step
procedure

¢ Commands typed at a prompt

¢ Userinput
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Monospace

Directories and subdirectories
File names and extensions
Process names

Code sample, including keywords and variables within text
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1 Introduction

This chapter provides an understanding of the OFS REG REP EBA application and its scope. It includes:
¢ Overview

¢ OFSAA Requlatory Reporting Architecture
¢ Scope

1.1 Overview

With the onset of regulatory requirements from a variety of regulators around the globe, financial
institutions are struggling to keep up with the constantly changing regulatory environment and the
regulators themselves are finding it difficult to analyse a pile of reports. In turn, the European Banking
Authority (EBA) introduced a common standard of reporting: one for Financial Reporting (FINREP) and
one for Common Reporting (COREP). The two standards use a very structured way of gathering data,
and also introduced the Data Point Model (DPM) along with the relational database to provide standard
meaning to all reporting elements.

The RRS EBA solution enables financial services organizations to manage and execute regulatory
reporting in a single integrated environment. It automates end-to-end processes from data capture
through submission with industry-leading solutions. It leverages Oracle Financial Services Analytical
Application (OFSAA) and Oracle Financial Services Data Foundation (OFSDF) for managing analytical
application data. The AgileREPORTER in Regulatory Reporting Solution (RRS) enables firms to
automate the final mile of the reporting process. It provides pre-built integration to Lombard Risk
Reporting, eliminating the need for further manual intervention. The solution ensures data integrity
allowing banks to focus more time on analyzing and gaining new business insight from their growing
stores of data instead of preparing data and reports with the sole objective of meeting submission
deadlines.

Oracle Financial Services Software 12



OFS Regulatory Reporting for European Banking Authority (EBA) — Lombard Risk Integration Pack
User Guide, Release 8.0.5.0.0

1.2 OFSAA Regulatory Reporting Architecture

Data Governance Studio

Data Sources

Trading Data

Currency Data
Master Data

L

Control Monitoring
Key Indicators

Issues and Action Plans
Metadata Browser

Enterprise

OFSAA Staging

Loans and Leases

Off Balance Sheet
products

Securities
Derivatives
Capital Data

MegmtLedger

General Ledger

OFSAA Results

Management Reporting

Analytical Engines

| Regulatory Capital Calculations

Calculations

ALLL, Fair Value, Economic Capital |

| StressExecutions

Reporting

Regulatory
Reporting

Lombard Risk
Reporter Portal

Management
Reporting

OBIEE

OFSAA — Analytical Application Infrastructure

Figure 1: Regulatory Reporting Solution Architecture

This interface connects the Oracle FSDF to Lombard Risk. As one can see in Architecture figure above,
Data flows from OFSAA to Lombard Risk.

OFSDF is an analytical data warehouse platform for the Financial Services industry. OFSDF combines an
industry data model for Financial Services along with a set of management and infrastructure tools that
allows Financial Services Institutions to develop, deploy, and operate analytical solutions spanning key
functional areas in Financial Services, including:

1. Enterprise Risk Management

2. Enterprise Performance Management

3. Customer Insight

4. Financial Crime and Compliance Management

OFSDF is a comprehensive data management platform that helps institutions to manage the analytical
data life cycle from sourcing to reporting and business intelligence/BI using a unified, consistent platform
and toolset.

AgileREPORTER is a forms and workflow tool that enables both creation and submission of regulatory
returns. AgileREPORTER addresses the financial reporting requirements of both domestic and
international banks and financial institutions by automating compliance with mandated reports to central
banks, regulatory agencies. AgileREPORTER works easily with multiple sources of information as it
standardizes data elements and automates regulatory report production in prescribed templates with the
associated workflow for automatic submission. It is Reliable and efficient infrastructure to compile,
generate and submit regulatory reports. It collects data from a wide universe (not just OFSAA Results). It
provides automated repeated manual adjustments, variance analysis and validation checks.
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The solution provides a pre-built interface or integration between FSDF and AgileREPORTER. With this
integration end user can automate end to end reporting process covering data preparation to last mile of

reporting.

1.3 Scope

Oracle Financial Services Regulatory Reporting for European Banking Authority (EBA) — Lombard Risk
Integration Pack covers the following regulatory reports for specified release as mentioned in the table:

Report Name

Schedule Name / Description

Released Version

Ratio

COREP - Credit Risk | C 07.00 Credit and counterparty credit risks and free deliveries: 8.0.3
Standardised Standardised Approach to capital requirements
Approach
COREP — C 17.00 Operational risk: Losses and recoveries by business lines | 8.0.3
Operational Risk and event types in the last year
COREP - Large C 26.00 Large exposures limits 8.0.3
Exposures
COREP - Large C 27.00 Identification of the counterparty 8.0.3
Exposures
COREP - Large C 28.00 Exposures in the non-trading and trading book 8.0.3
Exposures
COREP - Large C 29.00 Detail of the exposures to individual clients within groups | 8.0.3
Exposures of connected clients
COREP - Large C 30.00 Maturity buckets of the 10 largest exposures to 8.0.3
Exposures COREP - institutions and the 10 largest exposures to unregulated financial
Large Exposures entities
COREP - Large C 31.00 Maturity buckets of the 10 largest exposures to 8.0.3
Exposures institutions and the 10 largest exposures to unregulated financial

entities: detail of the exposures to individual clients within groups

of connected clients
COREP - Leverage C 40.00 Alternative treatment of the Exposure Measure 8.0.4
Ratio
COREP - Leverage C 41.00 On- and off-balance sheet items — additional breakdown 8.0.4
Ratio of exposures
COREP - Leverage C 42.00 Alternative definition of capital 8.0.4
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Report Name

Schedule Name / Description

Released Version

COREP - Leverage C 43.00 Breakdown of leverage ratio exposure measure 8.0.4

Ratio components: Off-balance sheet items, derivatives, SFTs and
trading book

COREP - Leverage C 44.00 General Information 8.0.4

Ratio

COREP - Leverage C 47.00 Leverage ratio calculation 8.0.4

Ratio

COREP - Liquidity C 72.00 Liquidity Coverage. Liquid assets 8.0.3

Coverage

COREP - Liquidity C 73.00 Liquidity Coverage. Outflows 8.0.4

Coverage

COREP - Liquidity C 74.00 Liquidity Coverage. Inflows 8.0.5

Coverage

COREP - Liquidity C 75.00 Liquidity Coverage. Collateral swaps 8.0.4

Coverage

FINREP F 01.00 Balance Sheet Statement [Statement of Financial 8.0.4
Position]

FINREP F 02.00 Statement of profit or loss 8.0.3

FINREP F 03.00 Statement of comprehensive income 8.0.5

FINREP F 04.00 Breakdown of financial assets by instrument and by 8.0.3
counterparty sector

FINREP F 05.00 Breakdown of loans and advances by product 8.0.3

FINREP F 06.00 Breakdown of loans and advances to non-financial 8.0.3
corporations by NACE codes

FINREP F 07.00 Financial assets subject to impairment that are past due 8.0.3
or impaired

FINREP F 08.00 Breakdown of financial liabilities by product and by 8.0.3
counterparty

FINREP F 09.00 Off-balance sheet items subject to credit risk 8.0.3

FINREP F 10.00 Derivatives: Trading 8.0.3

FINREP F 11.00 Derivatives - Hedge accounting 8.0.3
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Report Name Schedule Name / Description Released Version
FINREP F 13.00 Breakdown of loans and advances by collateral and 8.0.3
guarantees
FINREP F 14.00 Fair value hierarchy: financial instruments at fair value 8.0.3
FINREP F 16.00 Interest income and expenses by instrument and 8.0.3.1
counterparty
FINREP F 17.00 Reconciliation between IFRS and CRR scope of 8.0.5

consolidation

FINREP F 18.00 Information on performing and non-performing exposures | 8.0.3.1
FINREP F 19.00 Information on forborne exposures 8.0.3.1
FINREP F 20.00 Geographical breakdown 8.0.3.1
FINREP F 21.00 Tangible and intangible assets 8.0.5
FINREP F 22.00 Fee and commission income and expenses by activity 8.0.5
FINREP F 30.00 Geographical breakdown 8.0.5
FINREP F 31.00 Related parties 8.0.5
FINREP F 41.00 Fair value hierarchy 8.0.5
FINREP F 42.00 Tangible and intangible assets 8.0.5
FINREP F 43.00 Provisions 8.0.5
FINREP F 44.00 Net defined benefit plan assets and liabilities 8.0.5
FINREP F 45.00 Gains and losses on financial assets and liabilities/ on 8.0.5

de-recognition of non-financial assets

FINREP F 46.00 Statement of changes in equity 8.0.5
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2 Getting Started

This chapter provides an understanding of the pre-requisites, general and data preparation assumptions
and logging into the application. It includes:

¢

¢

¢

¢

¢

Prerequisites

Assumptions
Logging in to the OFSDF Interface with Lombard Risk for EBA

Organization of the Interface for User Roles

Metadata Browser

OFSDF interface with OFS REG REP EBA allows you to perform the following activities:

¢

Manage Data Loading and Transformation from various source systems to staging, processing,
and results.

Manage relevant OFSAA metadata for regulatory reporting purpose. This includes creating,
modifying, and viewing the metadata used in reporting.

View the report metadata for mapping.
Drill down from AgileREPORTER to OFSAA results area.

2.1 Prerequisites

The prerequisites are:

¢

¢

¢

Oracle Financial Services Analytical Applications Infrastructure (AAl) is deployed and configured.
Oracle Financial Services Data Foundation is deployed and configured.

Processed data required for reports as per the release scope.

Ensure that AgileREPORTER version 1.15.5-b1217 is installed.

Ensure that the report templates for AgileREPORTER (European Common Reporting (ECR))
Template version 1.26.1.3 is available in the AgileREPORTER.

Knowledge of working with regulatory reports.

2.2 Assumptions

OFSDF interface with OFS REG REP EBA is a reporting application and it does not perform any
risk/stress calculations. Following listed are the assumptions for the application:

¢

Textual and other related portions of reports like person details, contact details, Yes / No choices
must be updated on Report Portal directly and FSDF does not have placeholder for it.

Data provided is post reconciliation to ensure that accuracy of data being reported (non-
prescribed by regulators) are performed in OFSAA using various components — General Ledger
(GL) reconciliation.
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¢+ Validity checks such as edit checks, cross-validation checks and so on prescribed by regulator
are performed within the AgileREPORTER.

¢+ All monetary amounts are expected to be positive in number, except valuation outputs which can
be positive or negative. Rules are constructed assuming the negative sign of valuation amounts
wherever applicable.

¢+ The application populates few specific dimension tables, known as seeded / sample tables as
part of the installation script. Since they are used in the metadata, changes in data values have
impact on the overall functioning.

¢+ All percentage data are expected in decimal format meaning 9% must be provided as 9 and not
0.09.

¢+ For a data provided as of date, such as last day of the quarter of the reporting year: Quarterly and
Year to Date (YTD) report for the given date displays same value for those measures which are
of as of date in nature. For example, Annual and Quarterly Balance Sheet and BASEL reports
generated as of 31-MAR show same values for all measures such as Account Balance.

¢ Account Balances such as End of Period Balances are expected to be provided as Net of
(without) Unearned Income.

2.3 Logging in to the OFSDF Interface with Lombard Risk for EBA

After the application is installed and configured, to access the OFSDF Interface with Lombard Risk for
EBA application you need to log into OFSAAI environment using the OFSAAI login page.

To access application follow these steps:
1. Enter the OFSAAI URL in your browser. The OFSAAI login page is displayed.

' Financial Services Analytical Applications

ORACLE
Lenguzoe
User ID |
Password
-L .
[etoon ] ORACLE

Figure 2: OFSAAI Log In

2. Select the desired language from the Language drop-down list.
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3. Enter your User ID and Password. When you log into OFSAAI, the first screen is displayed.

B v A v | usengisnv | oFsap ¥

ORACLE Financial Services Analytical Applications

Object System Configuration & Identity My Inbox
Select Applications
A
Financial Services Analytical Applications Reconciliation Fra... ¥ 4 Common Tasks
Menu for Common Tasks
4[5 Common Tasks
+ B Data Model Management » Data Model Management » Unified Analytical Metadata
+ [l unified Analyiical Metadata Manage Data Model Define and maintain analytical metadata definitions
+ B Rute Run Framework . )
» B operations » Rule Run Framework » [% Operations
[ —— Framework to represent simple and complex: business logic in to Rules, Process Tools for Data Center operations
and Run paradigms
4 difa Reconciliation Framework
» Bsetup Metadata Browser
¥ &8 Reconciliation Definition Browse mefadala lineage
=K Run Management
» Bipata Entry 4y Reconciliation Framework
» BiReview N Reconciliation Framework
,%\ Setup , Reconciliation Definition
Setup Reconciliation Definition
=4 Run Management » Data Entry
Run Management Data Entry
B Review
B
Review
v

Figure 3: Landing Page
2.4 Organization of Interface for User Roles

This section explains the various features used by an analyst. It describes the organization of the user
interface and provides step-by-step instructions for navigating through the application to carry out these
activities.

Data Analysts are expected to perform the following activities:
1. Marking Run as Final
2. Executing Batch to Refresh Derived Entities
3. Drill Down from AgileREPORTER to OFSDF
Reporting Analyst are expected to perform the following activities:
1. Drill Down from AgileREPORTER to OFSDF
2. Using Metadata Browser to check Schedule Wise metadata

3. Using Metadata Browser to check metadata usage across schedules
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2.4.1 Marking Run as Final

Various applications provide data for regulatory reporting. You must mark specific executions for
regulatory reporting as final run.

B v A v | usengsnv | oFsapw

ORACLE Financial Services Analytical Applications

Applications | Object Administration ~ System Configuration & Identity Management My Inbox

SZEELETTERLS Financial Services Data Foundation > Run Management > Run Management
Financial Services Daia Foundation v

Run Management Summary
4 (@ Financial Services Data Foundation

» B Data Model Management 2 Search L& !
» B Data Management Frameworkc Segment EBASEG 4 Run Name
» [l unified Anaytica Metadata

. Run Type
» B Rule Run Framework
4 ZRun Management

2 List of Runs | B & [S1w202
BB Run Management

‘ Run Name Run Type Created By Created Date Last Modified By Last Modified Date V.
b [ operations EBA Regulstory Reporting Run BASELINE RUN SvsaDMN 11302016 Run Execution Summary. 12162016
» Bsetiings [] | EBA Source Base Run BASELINE RUN SYSADMN 121612016 B R

BB metacata Browser

Figure 4: Run Management Summary Screen

Run Execution Summary

Run Name £8A Reguiatery Reporting Run D 1480490204201

RunType BASELINE RUN

4 Run Execution Details | EECE |.s 1103 0f3
RunSkey ¥ Run Execution Id FIC MIS DATE Execution Status Execution Date Time of Execution Reporting Run Description

Approve Report flag

(=] 2 1497601834077 0612012016 COMPLETE 061202017 16:49:02 R Test

1 1453197118045 067302016 COMPLETE 0671972017 16:38:15 Approved

(=] 4 1502257585522 081092017 NEW R

4 Reporting Flag Details
Reporting fiag Status

Approved
Requesied By oFs4D
Requesied Date 08102017
Requestor Comments. Request
Authorized By oFsAD
Authorized Date oarnoR017
Authoriser Comments. Approved

Figure 5: Run Management Summary Screen

2.4.2 Executing Batch to Resave Derived Entities

To execute the batch to refresh derived entities, follow the below steps:
1. Navigate to Financial Services Data Foundation 2 Operations 2 Batch Execution

2. Select the batch <<INFODOM>>_REG_REP_EBA_DE_RESAVE to resave all the DEs used in
EBA.
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g = USEnglish v | OFSAD v
ORACLE Financial Services Analytical Applications

Object L System Configuration & Identity My Inbox

SIEEIITLE L Financial Services Data Foundation > Operations > Batch Execution
Financial Services Data Foundation

A
4 @3 Financial Senices Data Foundation e o |
» [ Data Model Management
» B Data Management Framework »Balch Mode

» [ unified Analytical Metadata ‘M""‘ @ Run (O Restart ()Renun ‘
Rule Run Frameworic

»Search
» & Run Management

4 [& operations
Modui e Last Modifcation Dats Betueen
1B Baten Maintenance fodule . | a ication Date ”

-3=N
s S EEm—— resne

Batch Execution

| »Baton Details [ 3 (R |
@ Batcn scheduler | [eatenio s | Baten Deseripton |
i Baten Monitor | EsANFo_ReG_REP_EBA _DE_RESAVE

Tis Bt Rosaves he KRS EBA Detvod Entty for Greaing WVIEWS \

Batch Cancelation
©view Log

»Task Details [
TaskD 4 Task Description | Mefadata Value

Processing Report t Tk or Resaving he
» B setings DERR1010

Task for Resaving the
Metadata Erowser Task2 RRS EBA DE -

DERRO10
Task for Resaving the

Task3 RRS EBA DE - MetadataReSave sh EBAINFO SYSADMN 856 DERRO1S  RUN EXECUTABLE Task2
DERRO15

Task for Resaving the

Taskd RRS EBA DE - MefadataReSave s EBAINFO SYSADMN 856 DERRO0S  RUN EXECUTABLE Tasks
DERROO:

Task for Resaving the

Tasks RRS EBA DE - MetadataReSave: sh EBAINFO SYSADMN 856 DERRO16  RUN EXECUTABLE Taske
DERRO16

e s

5178

[ Companentio recedence Tos Sats

MefadataReSave: sh EBAINFO SYSADMIN 856 DERR1010 RUN EXECUTABLE

MetadataReSavesh EBAINFO SYSADMN 856 DERRO10  RUN EXECUTABLE Taskt

»Infarmation Date

e

Execute Batch

Figure 6: Batch Maintenance Screen

3. Monitor status of the batch using Batch Monitor link.

g E US-Engiish ¥ | OFSAD ¥
ORACLE Financial Services Analytical Applications

Applications | Object Administration  System Configuration & Identity Management My Inbox

SELELGOTETD Financial Services Data Foundation > Operations > Batch Monitor
Financial Senices Data Foundation v

. Batch Monitor
4 [B3Financial Services Data Foundation

» B pata Model Management

»Search | |
Data Management Framework Batch ID Like [EBAINFO_ Batch Description Like RESAVE
» [El uniied Anaiyical Metacata — [
Rule Run Framework
Start Date

» 28 Run Management
4 [ operations

End Date =

[ Baten petans

s 1101 |
EEE T | Jeschina Baich Descrpion |
Batch Execution | & evamro_rec Rer_eoa e RESAVE T Batch Resaves the RS EBA Derived Enty for Creating MVIEWS |
18 Batch Scheduler »Batch Run Details [
@ Batch Monitor Information Date 20170622 v Monilor Refresh Rate (seconds) B
LR Lo £ Baich Run ID EBAINFO_REG_REP_EBA_DE_RESAVE_20170622_1 v
& viewLog
El Processing Report [ >Baten status 1
» B setings | [Bstenruno aton saus |
Motaget Brovser | eaanro_ree_nep_eoa_pe_Resave_ommoeas_1 Sucoessi I
»Task Details s a7
[Tesk0a e Motodsta Voo [ Tosk statvs
Task for Resaving the RRS EBADE - MeladalaReSave.sh, EBAINFO SYSADMN
[ Taskt Lok ore MetadataResa RUN EXECUTABH [13314] Successiul
Task for Resaving fhe RRS EDADE - MeladalaReSave <h EBAINFO SYSADMN
[ Task2 Sennoia i RUN EXEGUTABI [13314) Successful
Task for Resaving fhe RS EBADE - MeladalaReSave sh EBAINFO SYSADMI
[ Task3 Denaia 55 DERRITS RUN EXECUTABLE [13314) Successful
>Event Log &2 = 1202
Nessagel a [ Descipton [Sevoiy [Tims
8921 [1707] Batch started by OFSAD INFORM 2017-06-22 16:27-32
EQ [1708] Batch Complete INFORM 2017-06-22 16:35:13

Figure 7: Batch Monitor Screen
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2.4.3 Logging to AgileREPORTER to Retrieve the Returns

The Retrieve Return functionality in AgileREPORTER fetches data from OFSAA derived entities and
embeds them on AgileREPORTER templates. This runs the decision table process in Lombard Risk. You
can view the relevant OFSAA data on various schedules of the AgileREPORTER using this functionality.

Lombard Risk | Dashboard Job Manager 100 XBRL Checker - hisys %% @
‘Show Deleted Refums Delete Refum Log I Create New 5 import adjustments ~ Export To Regulator Format ) Bxport @) Retrieve Retum
Regutator WORKFLOW STATUS
ENTITY RETURNS ¢ VERSION ¢  REFERENCEDATE &  JOE STATUS UFDATE  APPROVAL EDITIONS ~ TRANSMISSION  MODIFIED & MODIFIED BY &
European Common Reporting v LYRA G
EUENtty 01  FIO1 1 061302016 Q0 g Updale  (0/1)NOT ATTESTED 08/0972017 145143 SYS &
Entity -
) Fl02 6/30/2016 (@] Update  (0/1) TED I 6 L]
EUEEo ] EUEniy 01 1 061302016 QC [ x] @ T ATTESTED 0713012017 20:08:46  SYS O]
EUEniity 01 FI04 1 06/30/2016 (R]@] [v]x] () Update  (0/1) 08/02/2017 17:00:25  SYS ]
Form
EUEntiy 01 FI0S 1 0613022016 QO €3 Update 0713012017 182534 SYS ]
EUEniity 01 FIOG 1 06/30/2016 R * § upsate  (on) 07312017 105421 SYS &
Available date
EUENtty 01 FIOT 2 061302016 Entity Updele  (0/1)NOT ATTESTED 071302017 18:26:35  SYS -
EU Entity 01 < =
EUEntly 01 FIO2 1 061302016 Consolidation - Solo Updale  (0/1)NOT ATTESTED 0713012017 20:0647  SYS O]
EUEntiy 01 FI08 1 0613022016 Reference Date Updsle  (0/)NOT ATTESTED 0713012017 182326 SYS &
EUEntiy 01 E110 1 0613022016 Update T ATTESTED 071302017 182437 SYS &
EUENtty 01 FI11 1 0613022016 Form Update T ATTESTED 071302017 182913 SYS &
EUENtty 01 FI12 1 0613022016 Logreve Update T ATTESTED 0713012017 20:0823  SYS ]
EUEntly 01  Fi14 1 001302016 Updsle  (0/1)NOT ATTESTED 071302017 20:10:12  SYS &
EUEntty01  FI16 3 06/30/2016 oK m Update T ATTESTED 07/31/2017 10:55:45  SYS ‘.*
EUEntiy 01 Fl18 1 0613022016 YT ——————, Updale  (0/)NOT_ATTESTED 071302017 20:0158  SYS &
EUENtty 01 EI19 1 061302016 Q0 g Updale  (0/1)NOT ATTESTED 071302017 20:02:12  SYS ]
EUEntly 01 FI20 2 061302016 Q0 ) Updale  (0/1)NOT ATTESTED 0713012017 19:55554  SYS -
1 100[%]

Figure 8: Retrieve Returns Page

2.4.4 Report Verification - Drill Down from AgileREPORTER to OFSAA Results Area

Drill down functionality enables the user to view the accounts included in the aggregation. Following these
steps to drill down from AgileREPORTER to OFSAA:

1. Loginto the AgileREPORTER.

Lombard Risk

Automated regulatory compliance

Highly scalable for global volume processing capability enables AgileREPORTER to be extended for
other business units and geograp! as business requirements evolve

AgileREPORTER® [l
R, i’ ’ p‘assword
it 2P

Lombard Risk

Figure 9: AgileREPORTER Login page
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2. The user can view the list of reports in the main page. Click any report name in the Returns
column, for example, FI04.

Lombard Risk | Dashboard

Regulator -

Entity

Form

Available date

ENTITY RETURNS &
European Common Reporting

EUEnity 01 FI01

Fl02
EU Entity 01 ~| EuEMyOl HOZ

EUEnity 01 Fio4

FuEmyon EE

EUEnity 01 FIOB
FuEm o B
EUEnity 01 FI08
EUEnity 01 EI09
EUERity 01 EI10
EUERity 01 EI11
EUEntty 01 FI13
EVENty 01 Fli4
EUEnily 01 EI16
EUERity 01 FI18

EUEnity 01 E119

Show Deleted Retums Delete Retum Log &) Create New B3 1mport agjustments ~ Export To Regulator Format

WORKFLOW STATUS

VERSION ¢ REFERENCEDATE ¢ JOB STATUS UPDATE  APPROVAL EDITIONS ~ TRANSMISSION
LVXAE

1 061302016 [<]@] €2 Updale  (O/1NOT ATTESTED

1 06/30/2016 0 [x] (3 Update  (0/1)NOT ATTESTED

1 06/3012016 [:]®] [v]x] {4 Update  (0/)NOT ATTESTED

1 0613022016 [r]@] {3 Updale  (0/1)NOT_ATTESTED

1 06/30/2016 R0 {3 Undate  (0/1)NOT ATTESTED

2 06/30/2016 [:]@] [v]x] (3 Update  (0/1)NOT ATTESTED

1 061302016 [r]@] €2 Undale  (0/1NOT ATTESTED

1 061302016 [r]@] {4 Undate  (0/1)NOT ATTESTED

1 06/3012016 [R]@] [v]x] {4 Update  (0/1)NOT ATTESTED

1 06/30/2016 [R]@] {3y Undate  (0/1)NOT ATTESTED

1 0613022016 [r]@] €2 Updale  (O/1NOT ATTESTED

1 06/3012016 [R]O] [x] {4 Update  (0/1)NOT ATTESTED

3 061302016 [r]@] {4 Undate  (0/1)NOT ATTESTED

1 06/3012016 [R]@] (3 Update  (0/1)NOT ATTESTED

1 061302016 ®0 €2 Updale  (O/1NOT ATTESTED

1 100 V]

[100] XBRL Checker  ~ hisys E-]

£ Export @) Retrieve Retum

MODIFIED & MODIFIED BY &

0810872017 145143 SYS

0713072017 200846 SYS

0300272017 7:0025  SYS

0713072017 18:2534  SYS

0713172017 105421 SYS

0713072017 18:2635  SYS

071302017 200647 SYS

071302017 182325 SVS

0713072017 18:2437 VS

071302017 182013 SYS

071302017 200823 SYS

071302017 2011012 SYS

0713172017 105545 SVS

0713072017 200158 SYS

0713072017 200212 SYS

W W = w w =W w = = « " « =G«

[ 1]

Figure 10: AgileREPORTER Main Page

3. The schedule list is displayed in the right hand side. Click any schedule name, for

Table 4.1.

example,

4.1 Financial assets held for trading

A show Import Log ~ Adjustments

4. Breakdown of financial assets by instrument and by ¢

~ Export ToFile

Lombard Risk  Fl04v1 European Common Reporting/ EU Entity 01 06/3012016

~ Export ToRegulator Format | ) Live Validation | Y Vaiidate Now = Worklow

Not Attested (0/1)

Show Scale

References ~ Accumulated changes in fair value due to credit risk
Carrying amount
Tinnex V.Part 2.4
010 020
010[equity instruments lwas 32.11 350,049
020 of which: at cost a5 35.45(c) 137,621
030 [of which: credit institutions lannex v.part 1.35(c) 12,775
040 of which: other financial corporations _|Annex v.Part 1.35(d) 7.783
050 [of which: non-financial corporations  |Anmex V.Part 1.35(e) 132,188
050 |Debt securities Vinnex v.part 1.24, 26 1870028 127,220
070| Central banks annex v.part 1.35(2) 218,953 7430
080| General governments innex v.part 1.3506) 360,748 34,359
090| " Credit institutions lannex v.rart 1.55(c) 308,284 20672
100| Other financil corporstions innex v.part 1.3502) 171,918 4,111
110 oo Fnancil corporstions lamnes v.port 1.3502) 501,119 55557
120 [Loans and advances innex v.part 1.24, 27 1,162,606 97,808
130| Central banks lannex v.part 1.55(a) 166,302 13249
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Table 43 P1

Table 4.3 P2

Table 4.4 P1

Table 4.4 P2

Table 45

Figure 11: AgileREPORTER Page Displaying List of Schedules
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4. Click any cell to drill down. Figure 12 displays drill down for the cell. The OFSAA icon is
displayed.

Lombard Risk FI04 v1 European Common Reporting / EV Entity 01 06/30/2016 Not Attested (0r1

A Show Import Log ~ Adjustments ~ BxportToFle - Export ToRegulator Format 57 Live Validation 51 Validate Now ~ Workfiow
Editions | 0771112017 11:00:51 #1 v (Dl instances 1 -

Show Scale a P

o
o
o

Table 4.2
Table 4.3 P1

Table 4.3 P2

Table 4.4 P1
dizect ceil sait
° 7479751112 TEst Table 4.4 P2

OFSAA

Table 4.5

Figure 12: AgileREPORTER Drill-down (OFSAA Icon)

5. Click the OFSAA icon, to view how this cell was populated (provides information about the
amounts reported in a cell) from OFSAA results. You are redirected to the OFSAA drill down
page.

Data Lineage
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Legal Entty EU Entity 01 Reference ientiier

» Derived Entity : DE- IFRS Account Summary  (15) =

iredFiag | Seniority Flag  |Over The Counter indicator  |Buyor Sellfisa | Semior ClaimFlag | nstrument Contract indicator | Requlatory Credit Status Code | Trading Account Book Type Code  |Hedge Type | Cumulative change in FV due to credit risk RCY.

0 s 0 ns
0 s 0 TRLIADER
0 s 0 TRUADER 225150472
0 s 0 2375570
0 B
0 B 0 TRLIADER PPy ECr)
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0 s 26720816
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Figure 13: AgileREPORTER Drill-down
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6. This cell is populated from the derived entity mentioned in the grid header DE — IFRS Account
Summary. The value in the derived entity grid 7479.751112 (rounded to 7,480) is sum of the
Cumulative change in FV due to credit risk RCY must match with that of the cell in the report.
Derived entity is an aggregate built on top of OFSAA results model to serve regulatory template
requirements. It is built using dimensions, measures and business processors. The dimensions
that participates in determining the cell value is displayed with data. Click the Derived Entity link
in the grid header.

Data Lineage

Run Executon id Date
Legal Entity Reference ientifier
» Derived Entity ; DE- IFRS Account Summary  (15) i) v
Beaulatory Product Type Code | Standard Party Type Code | Requlatory Product Type Group Code | Requlstory Product Type Code Leveld | Holding Type Code | Irading Flag | Reported At Fair Value | impaired Flag | Seniority Flag | Over The Counter Indicator|
DEBTSEC cBic DEBTSEC FNAST T 5 c v [
DEBTSEC ] HFT B c N
DEBTSEC = = = [~ HET B F u
Derived Entity r
DEBTSEC HET 8 F [ [
DEBTSEC T 5 c [ [
DEBTSEC HFT 8 F N [
DEBTSEC Code/D DERRSO1 Name DE- FRS Account Summary. W B 3 N f
DEBTSEC Description  DE- FRS Account Summary Foider pre s c u f
DEBTSEC T 8 c [
= Detais | Statistics | Audt Tral
DEBTSEC HET B F N u
~ Derived Entity Properties (3; s
< = ity Props 3) >
HE | name Value
Source Type Dataset
Aggregate Flag es
Wateriaized View Ves
< >
+Dependson (27) 116 Jump to Page s
= | obiect Name Obisct Type
Cumuative change in FV due to credt
o Weasure
— v
Carrving Vale RCY Weasure

Figure 14: Data Trace Browser / OFSAA Report Drill-down Screen

Derived entity details are displayed in the Metadata Browser within the page. Scroll to view
complete details such as Datasets, Hierarchies, Measures and so on.

7. Double-click any figure in the screen to drill-down to the fact tables. The below grid displays the
detailed granular rows of fact data that comprises the derived entity aggregate. Scroll to the right
in second grid to view the values.

Data Lineage
[ "
Borived Entity | OF IFRS Account Summary  (15) )
duct Type Code Hedge Type Tisding Flag Over Ihe Coumer indicaor Buy 01 Sell Flag Tuading Account Book Type Code Beguiaory Product Type Code Levell Inatument Contact dicator Senlor Clobo |log Cumulative change in [V due 10 coedk dsk BCY
B ; FNAST
18T
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T a4
T 4441
< >
g
Datas ot : DEAFRS Account Summary (L]}
iy IypaCods | Lrading Account Baok Typs Code Ot lndiator  Senlority Of Security ndicator  Samiority Claim Flag | Trading Book lidicator By O Selllndicator  lmpaired Flog | Roported ALFai Vilus Flog  Cumulths Change ki Py Do To Cradk Ak b Asporting Curs
i
< >

Figure 15: Derived Entity MDB View
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8. Click Attribute Selector icon on the header of the second grid.

st

Derlved Entit

1 Type Code

y + DE. IERS Account Summary,

IpaCode  Medge Type  Itadig Flag
[

latas et : DS.IFRS Account Summary (%)

Trading Account Book Type Code

Data Lineage

Contract Indkator  Senior Clim Flog  Cumuladive chonga bn BY dus 1o craedit ¢

bo  Heported AuFair Value Flag  Cumuliive Change In Fy Due To Credit Risk in Reporting Cur

Figure 16: Drill-down Attribute Selector 1

9. Expand Data Entities and select Attribute to be shown in the drill-down. Click OK.

duct

ity Type Cade

Dorived Entity : OE- IFRS Account Summary

TypeCode | thdgeType  Tosding Flsg

Dot as ot DSIERS Ackaunt Summary

Liading Account Back Type Cade
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i Flog | Cumulative changs in PV dus 10 coodi tisk RCY
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Figure 17: Drill-down Attribute Selector 2

NOTE: Select the required Data Source, from the Available list and click L= icon. You can press Ctrl
key for multiple selections. To map all the listed Data Sources to the application, click & icon.
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10. If Accumulated Charge in Fair Value details are required, scroll and click the column header.
The details are displayed in a separate window.

< ¥
)

Datas et : DS.IFRS Account Summary (%)

Seniotify Of Security Indicator  Semiority Clim Flag  Irading Book Indictor  Buy Or Sellindicatos  Impsired Flag  Reporied ALFail Vilue Flag  Accumulated Change In Fak Vs In Reporting Currency | Gumulative Change In Fy Due To Credi Risk In Reporting Currency

Al os
Columns

Depends an (0)

Usedin (2)

Figure 18: Drill-down - Columns

2.5 Metadata Browser

This section helps you to navigate through Metadata Browser and guides you in tracing the source of the
metadata. The Metadata Browser function allows you to view and analyze all aspects of the metadata
used in the OFSAAL. It provides extensive browsing capabilities of metadata, helps in tracking the impact
of changes to metadata, and trace through to the source of originating data.

Metadata Browser (Object and Application View) provides common repository of metadata objects
created in OFSAAI and applications hosted in OFSAAI. Using this view, you can identify the usage of
base objects in higher level objects and the mapping of Objects to Application, thus enabling traceability.
It also allows you to view the data flow and the work flow of the application and understand the usage of
objects within the application.

The new visualization of Metadata Browser (MDB) supports Application view and Object view. In
Application view, you can browse through the metadata created using the applications hosted in OFSAAI.
In object view, you can view the metadata created in OFSAAI.

To access the Metadata Browser (Object and Application View), your role must be mapped to the
SCR_MDB function.

Analysts review the metadata used for a particular report schedule to verify the data. Data verification
may require looking for metadata used in given schedule or it can be schedules in which particular
metadata is used. Data Analysts and Reporting Analysts perform the report verification. Metadata refers
to business measures, hierarchies, data sets, derived entities used for a given schedule.
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To use MDB for schedule wise metadata, and to use MDB for metadata wise schedule follow the below
steps.
1. To use MDB for schedule wise metadata, for a given schedule, identify the metadata used.

a) User can verify the data for related data elements in results using this information.
Navigate to path Objects 2 OFSAA Data Model 2 Reporting Metadata 2 Reports.
The Left Hand Side (LHS) displays the list of reports. For example, Figure 19 refers to
FI0401 report.

Metadata Browser Last Executed Date : 10-Aug 2017 22 1842 User: OFSAD Conmected To: FSOFIFO
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Report URL
= Depends on (1) =
# | Otiect Hame Obpct Type
4089 view
= Usedin (1) =
# | Otject Name Obpct Type
| 1) Dashboard
» Applications (0}

Figure 19: MDB - Reporting Metadata - Schedule View 1

b) Click the object view FI04-FI0401. The Report Details page is displayed.
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Figure 20: MDB - Reporting Metadata - Schedule View 2
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You can view the below information in the Details tab:

¢ Reporting Elements: This section displays the line items in report with
regulatory references.

¢ Depends On: This section displays the metadata used in a given schedule.

¢+ Used In: This section displays the Reports in which this schedule is used.

¢ Applications: This section displays the applications in which this schedule is
used.

c) Click any Reporting Element. For example, FI0O401R140C010. The following page is
displayed.
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Figure 21: MDB - Reporting Metadata - Schedule View 3

You can view the following information in this page:

¢ Reporting Element Properties: It provides information on line items or cell
references in regulatory reports.

Table 2: Fields and their Descriptions in Reporting Element Properties

Fields Description
Derived Provides information on whether the cell is derived / computed using
other elements.

Confidentiality Refers to regulator specific interpretation.

Type Refers to regulator specific interpretation.

Notes Refers to regulator specific interpretation.

Start Date Refers to regulator specific interpretation.

End Date Refers to regulator specific interpretation.
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¢+ Dimension Filters: This section displays the dimensions and node value filters used
to derive a particular cell.

¢ Depends on: This section displays all the hierarchies (dimensions, filters) and
business measure used for arriving at a particular cell / MDRM code.

¢ Used In: This section displays the Objects in which this schedule is used.

¢+ Applications: This section displays the applications in which this schedule is used.

2. Starting from a common metadata used across application, you may want to know the list of
reports/ derived entities this metadata has used. Let us take an example of measure. To identify
how a value has been computed, follow these steps to trace it back to the metadata:

a) To view the measures, navigate to path Objects = OFSAA Data Model 2 Business
Metadata = Measures. The LHS displays the list of measures. For example, Figure 22
refers to ALM EOP Balance RCY.

DUpDooUooouL

JODDUDDL

Figure 22: MDB - Business Metadata - Measure View

You can view the below information in this page:

¢ Measure Properties: It provides information on properties of Business measures.
For example aggregation function, Measure Data Type, Business Exclusions, Filter
and Rollup Type.

¢ Depends on: This section displays all the object names and their types, such as
Entities, Columns and so on.

¢ Used In: This section displays the Objects in which this schedule is used.

¢+ Applications: This section displays the applications in which this schedule is used.
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Follow these steps to view the derived entities used in a given schedule:

Note: The similar steps as below are applicable for other metadata such as Business Metadata
(Hierarchies, Measures, Variables and so on) and Derived Metadata (Dimensions, Filters
and so on).

a) To view the schedule wise derived entities, navigate to path Objects 2 OFSAA Data
Model - Derived Metadata - Derived Entities. The LHS displays list of Schedules.
For example, Figure 23 displays the derived entities used in FCT IFRS Account
Summary.

Last Executed Date : 16-A00-2017 221642 User: OFSAD Connected To: FSOFNFD

ORACLE

Detsts | Stataties Aot Trak
Derivad Entity Proparties {3)

‘Sowrce Type Oadaset
Aggrogate Fag s

uz Jump ta Page L)

Figure 23: MDB - Business Metadata — Derived Entity

You can view the following information in this page:

¢+ Derived Entity Properties: It provides information on properties of derived entities,
such as Source Type, Aggregate Flag, and Materialized View.

¢+ Depends on: This section displays all the object names and their types, such as
Measure, Hierarchy, and so on.

¢ Used In: This section displays the Objects in which this schedule is used.

¢+ Applications: This section displays the applications in which this schedule is used.
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3 Regulatory Reporting Solution Data Flow

This chapter provides an understanding of the data flow. It explains what happens within data flow and
how various processing aspects are integrated with the overall data flow.

It includes:

¢

¢

¢

Data Preparation

Mapping of Results to Line Items in Reporting

AgileREPORTER: Submission

3.1 Data Preparation

This section explains the input data preparation from OFSAA. It includes:

¢

¢

3.11

Assumptions for Data Preparation

Run/Execution Expectations

Projection Data

Data Flow from Sources Systems to Staging Area

Data Flow from Staging to Results Area

Data flow from Staging to Processing Area

Data Flow from Processing to Results Area

Dimension Tables/Entities

Assumptions for Data Preparation

RRS is a reporting solution, which uses data from underlying fact tables directly for reporting. The
end user is expected to prepare the load for the required data in reporting area accordingly.
Although this has a thin processing layer to reclassify to regulatory dimensions and bands, all the
processing measures are expected to be from respective applications and provide as required.

It is integrated with results area of the respective processing application, and any change in the
underlying processing can disturb the RRS data sourcing.

Baseline and stress data must be populated with appropriate codes. Inaccurate mappings may
lead to inaccurate results. For details please refer to Relationship between Run and Stress.

For usage of consolidation dimension (which has values like Actual, Budged, Forecast, and so
on), all historical data is expected to be tagged as actual for the purpose of reporting vintage
data, as per report requirements. For projection data, for a given run and Projection Period
(quarter/year), only one set of data is expected to be stored.

All processing reporting requirements requiring cash flows, integration package expects bucketed
cash flow as a input (meaning a time bucket for cash flow and cash flow amount is expected as
input).
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3.1.2 EBA RUN CHART

Oracle Financial Services Regulatory Reporting for EBA — Lombard Risk Integration Pack provides the
EBA RUN Chart listing the tasks required for population of data for EBA Reports. This covers the
following tasks:

¢

¢

¢

¢

Set up table population

Stage Dimension Load

Seeded Dimension Data Population

Common data Population

Common Tasks like Exchange Rate Population
EBA Specific Data Population and Transformation

Derived Entity Refresh

Download the EBA 8.0.5.0.0 RUN Chart from the MOS.

3.1.3 Run/Execution Expectations

Run refers to execution. It is assumed that at different time periods, different combination of parameters,
and different data require different executions. From a reporting perspective, as required by regulators,
data is required for the following executions:

1. Current Data / Execution

a. Reporting month end data
b. Projection Data

2. Historical (trend/vintage) Data

a. Yearly
b. Quarterly

3. Stressed Data

Note:

¢

For Movement measures data is not carried from one reporting period to another. For example,
Profit or Loss. Where General ledger balances such as loan outstanding are carried forward from
one year to another, profit and loss is period specific.

Therefore, unlike End of Period (EoP) balance, movement values for quarter actuals must be
derived for reporting. For a historical data, net sales for quarter 3 is the difference between sales
figure as of end of quarters 2 and 3. You do not need to provide this difference as a download.
Movement data for actual is identified through different runs and the respective values is summed
up.

Only those records, whose corresponding runs fall between the fiscal month start date and end
date of the reporting quarter are selected for summation. Each Run has an associated date, and
runs can be performed daily. Assuming that runs are performed daily in a given quarter (90 days),
RRS sums up data points across all 90 days to arrive at a quarter end movement figure.
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¢+ However, when projection of net sales for quarter 2 next year is to be performed, no derivation is
required. Projections data for said quarter can be directly downloaded in the respective Fact
table(s) for reporting.

3.1.4 Data Flow from Source Systems to Staging Area

The staging area is populated with data from various data sources, such as GL data, Account data,
Customer data, Trading data, Currency data, and Master data. See Data Integration Hub (DIH) User
Guide in OTN Documentation Library for details. DIH enables to load the data from the source systems to
the OFSAA staging tables, through logical interfaces, known as Application Data Interfaces (ADI). DIH
provides a set of User Interfaces (Ul), which is used to define and maintain External Data Descriptor
(EDD), Application Data Interfaces, and map the EDDs and ADIs through connectors.

3.1.5 Data Flow from Staging to Results Area

This section details the pass through data, transformed data and classification.

3.1.5.1 Pass Through Data

Pass through data refers to the static data that is pre-processed and flows to the results area directly. The
Common Staging Area (CSA) model represents the data entry point into the FSDF. CSA provides a
simplified, unified data sourcing area for inputs required by analytical applications and engines. It consists
of over 400 tables and nearly 9000 columns organized into distinct subjects.

The staging area is a physical data model, which is deployed using the Analytical Application
Infrastructure, which manages it. The design of the staging area data model is to allow efficient data
loading for analytics. It thus has crucial differences from a general-purpose repository of
operational/transactional data across a bank.

The staging area acts as the single source of data, and contains unified data requirements for various
banking areas such as Loans and Losses, Off balance Sheet products, Securities, Derivatives, Capital
Data, Management Ledger and General Ledger. Common example of this category includes various
monetary amounts, dates and so on.

3.1.5.2 Derived / Transformed Data and Reclassifications

OFSDF Interface with Lombard Risk for EBA requires specific hierarchies and data to be transformed and
reclassified to regulator specific values.

Table 3: Data Transformation Example

Source Hierarchy Target Hierarchy

Maturity Date As-of-Date DIM EBA Remaining Maturity

This rule uses the bank-specific data coming at account level, such as maturity date. The difference
between the maturity date and the as-of-date is computed to arrive at the remaining maturity band.
However, these values are bank specific, and must be converted or reclassified to regulatory specific set
of value such as DIM EBA Remaining Maturity Band as mentioned above.
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Reporting derived entities use this reclassified dimensions. Some of the reclassifications are performed in
the respective application area.

For example, DIM BASEL PRODUCT TYPE. This reclassification is performed in Basel application
processing and available for reporting directly.

Other transformations include various bands such as delinquency band, loan purpose and so on.

3.1.53

Re-classified to Regulatory Classifications

After transformation, the regulatory data is reclassified as follows:

Table 4: Data Reclassification Example 1

Source Attribute Interim Target Target
DIM PRODUCT Withdrawable Reserve | DIM STANDARD PRODUCT | DIM REG PRODUCT
Checking Accounts =N CASA Current Accounts

Table 5: Data Reclassification Example 2

FCT REG ACCOUNT SUMMARY

Account Number REG PROD Classification Remaining Maturity Band

Delinquency Band

OTHER TERM LOAN 1

3

The sample reclassifications performed to transform the existing hierarchies to regulatory specific

hierarch
.
.
.

ies are:
Regulatory Product Classification
Regulatory Instrument Classification

Trading Account Book Type Classification

The additional transformations that are performed are:

¢
¢

Remaining Time to Maturity Band
Regulatory Delinquency Band

Within reclassification rules, few rules where source is customer specific values. In such cases, these
rules must be validated and updated as required by end user because Out of Box rule may differ from
what end user has. Such rules are very few and restricted to:

1.

a s N

Refer to

Standard Product Type Reclassification
Standard Party Type Reclassification
Standard Mitigant Type Reclassification
Regulatory Industry Reclassification
Regulatory Credit Status Reclassification
Regulatory Loan Purpose Reclassification

Business Metadata for details of these reclassifications.
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3.1.6 Data Flow from Staging to Processing Area

The staging area of the FSDF serves as a container for analytical processing from sourcing to
consumption. Such processing is usually delivered in the form of discrete units called analytical
applications, spanning different analytical use cases ranging from Finance to Risk to Compliance.

These applications consist of custom-built computational engines and numerical libraries, and can
execute processes on the data that range from simple aggregations to complex, multi-step stochastic
processes such as Monte-Carlo simulation.

Hence, analytical applications place varying demands on the data infrastructure in terms of volumes and
speed, and hence place different demands on the data architecture. In practice, the normalized (3NF)
design favored for enterprise data warehouses often fails to be efficient or performant when it comes to
analytical processing across a wide range of use cases.

Therefore, the OFSDF recognizes the need for distinct application-specific working stores, separate from
the staging and reporting area. For example, the OFSAA Asset and Liability Management (ALM)
application has a distinct set of ALM-specific tables, as does the Market Risk solution.

Note: The structure of these processing area stores is decided by the actual analytical application and
engine used. The OFSAA suite of applications is organized this way, with each application managing a
specific set of tables/schemas within the processing area.

The processing area tables/schemas are not part of the OFSDF. This is because OFSDF is intended to
be an open platform. Other analytical applications and engines can equally provision data out of OFSDF
by mapping their input requirements appropriately to the OFSDF staging area model.

3.1.7 Data Flow from Processing to Results Area

This step is similar to Data Flow from Staging to Results Area. It involves either pass through data from
processing to results or loading directly to results (refer Section 3.1.8). This is mostly due to processing
measures such as Fair Value, Risk Weighted Assets, and so on.

3.1.8 Guidelines for Data Loading to Result Area Tables in Data Foundation for
Regulatory Reporting Implementations

Regulatory reports make use of data available across several fact tables in the OFSAA data foundation
model and these result tables are either loaded from the raw data sourced from source systems via out of
the box T2T’s or processed data output from various OFSAA applications.

For example, Fact LRM Account Summary (FCT_LRM_ACCOUNT_SUMMARY) which stores the liquidity
risk related attributes and metrics computed by OFSAA LRM application, Fact Loan Loss Forecasting and
Provision Account Summary (FCT_LLFP_ACCOUNT_SUMMARY) which stores the attributes and
measures computed by OFSAA LLFP application. However, there can be several implementation use
cases in the regulatory reporting space where customer may not have licensed any of OFSAA application
and hence must put additional custom effort to design an ETL process to load the required data elements
into the respective fact tables referenced by the report. The following section highlight some of the
guidelines that the customer can consider when designing a data flow for such a use case.
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¢+ Consistent Usage of Run Identifier

Most of the fact tables used in regulatory reporting are run enabled and have a composite primary
key inclusive of run identifier that enables same snapshot of data to be loaded multiple times into
the target fact table for any given execution date. All the out of the box processes that impact
data used in regulatory reports are executed as part of an integrated run to ensure that run
identifier is consistent across fact tables. Since the reporting is done on an integrated schema, it
is imperative for the custom data flow design to keep this integrity intact. This essentially means
that the custom ETL processes designed to load the data directly into the fact tables must be able
to leverage the run identifier generated by the run engine during execution. Run Identifier
information is available in DIM_RUN table.

¢ Correct Dimensional Lookup Configuration

Dimensional identifiers are typically part of referential integrity constraints with the fact table so
the custom ETL processes must ensure that lookups retrieve a valid surrogate keys for a given
value of business key. The intermediate staging structure must ensure all the business keys are
persisted correctly and the lookup condition is designed on the correct dimension table.

For example, FCT_LRM_ACCOUNT_SUMMARY.n_asset_level_skey >
DIM_ASSET_LEVEL.n_asset_level_skey. The business key (v_asset_level_code) must be
sourced and persisted to ensure correct values are populated in the target column, that is,
FCT_LRM_ACCOUNT_SUMMARY.n_asset_level_skey.

From OFSAA technical infrastructure standpoint, the mentioned options are available to the customer to
design and implement the custom ETL process explained above. OFSAA strongly recommends the below
options to maintain consistency in terms of data lineage in Metadata browser as the configured metadata
can be made available in meta model via MDB publish:

1) Data Integration Hub (DIH) Connectors
2) Data Mapping (T2T) option in Application Infrastructure
3) Data File Mapping (F2T) option in Application Infrastructure

3.1.8.1 DIH Connectors

For customer’s that have licensed DIH to source data from external systems into OFSAA, this probably is
the easiest approach to load data into the result area table. Source data could either reside in relational
structure or in a file structure. Mappings maintained in DIH are logical in nature while physical
implementation is managed internally. Dimensional lookups work seamlessly without the need for any
additional configuration in the connector mapping as this too is managed internally by DIH. Refer to DIH
user for details on how to load data into a result area table.
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Figure 24: DIH Connectors

3.1.8.2 Data Mapping (T2T)

Data Mapping refers to the process of retrieving unstructured data from data sources for further data
processing, storage, or migration. This feature is commonly known as RDBMS source to RDBMS target
(T2T) framework in the OFSAA world and can be leveraged when source data is available in Oracle
database. Dimensional lookups must be handled via the T2T’s join condition and expressions. Refer to
OFS AAIl User Guide for more details on configuring a T2T.

3.1.8.3 Data File Mapping (Flat File to RDBMS Target - F2T)

If the source data is available in file structures, OFSAA F2T component can be used to bring the data in
the OFSAA eco system. As lookups cannot be configured in a F2T, this component must be used in
conjunction with T2T component, that is, data is first loaded from the file to an interim staging structure
using the F2T component followed by data load to the target result area table using the T2T component.
This is least recommended approach as there is need for interim table structure in data model and
involves multiple data hops which add to the overhead.

Refer to the OFS AAI User Guide for more details on configuring a F2T.
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3.1.9 FSDF Entity Information

3.1.9.1 Dimension Tables/Entities

Table 6: Dimension Seeded Tables/Entities

Sl.

No.

List of Seeded Tables

Table/Entity Logical
Names

Table/Entity Descriptions

DIM_ACCOUNT_CLASSIFICATION

Account Classification

Dimension

This entity stores the account
classifications according to
different regulations.

DIM_ASSET_LEVEL

Liquidity Asset Level

This table stores the various
Assent Level that can be assigned
to the account. Under Basel
Accord an account can be either
Level 1 Asset or Level 2 Asset or
Other Asset.

DIM_BANDS

Bands Dimension

This table stores the list of band
dimensions. Information on the
table name, columns containing
the band codes, upper and lower
bound values are stored in the
setup table and a generic code is
executed to populate the band
codes in the respective fact
tables.

DIM_BANKING_ARRANGEMENT

Banking Arrangement
Dimension

This table stores the banking

arrangement codes.

DIM_BASEL_ASSET_CLASS

Basel Asset Class

This table stores the Basel
defined Asset classes used to
arrive at the relevant risk weight
category or calculation formula.

DIM_BASEL_BANK_ROLE

Basel Bank Roles

This table stores the Bank Role
type as defined by Basel Accord.

DIM_BASEL_CREDIT_RATING

Basel Credit Ratings
Dimension

This table stores the Basel
defined Credit Ratings

DIM_BASEL_METHODOLOGY

Basel Methodology
Dimension

This table stores the Approach
Methodology as defined by Basel
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Sl. List of Seeded Tables Table/Entity Logical Table/Entity Descriptions

No. Names

9 DIM_BASEL_PRODUCT_TYPE Basel Product Types This table stores the product type

Dimension as defined by Basel.

10 DIM_BOOLEAN_FLAGS Boolean Flag Dimension This table stores the list of the
Boolean Flags.

11 DIM_CLEARED_TXN_BANK_ROLE Cleared Transaction Bank This table stores the role of the

Role Dimension financial institution in the
transactions cleared by central
counterparties, for example:
Clearing Member, Clearing
Member Client.

12 DIM_CONSOLIDATION Consolidation Dimension This entity stores details of
various kinds of values to be
analyzed like actual or budget.

13 DIM_COUNTRY Country Dimension This table stores country
dimension data.

14 DIM_CREDIT_LINE_PURPOSE_CAT Credit Line Purpose This entity stores the purpose

Category Dimension category of credit line which is
available for liquidity, credit, both
or other. This may have four
values:

LIQ (=Liquidity),

CRT (=Credit),

BOT (=Both Liquidity and Credit),
OTH (Others).

15 DIM_CREDIT_RATING Credit Rating Dimension This table stores the credit rating
information.

16 DIM_CURRENCY Currency Dimension The table stores the currency
information.

17 DIM_DELQCY_WORKOUT_PROGRAM Delinquency Workout This table stores the loss /

Program Dimension

delinquency workout program
associated with loans. Workout
program are defined generally as:
if particular program is deferment,
forbearance, term changes, rate
changes, and so on.
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Sl. List of Seeded Tables Table/Entity Logical Table/Entity Descriptions
No. Names
18 DIM_DEPOSIT_PRIM_PURPOSE Deposit Primary Purpose This table stores the primary

Dimension

purpose of deposit. The list of
Values are:

(1) PAYREMIT = Payment
remittance;

(2) SAFEKEEPING =
Administration of payments and
cash flows related to the
safekeeping of investment assets,
Not including the purchase or sale
of assets;

(3) PAYROLLADMIN = Payroll
administration and control over
the disbursement of funds;

(4) PYMNTORDER =
Transmission, reconciliation, and
confirmation of payment orders;
(5) DAYOVERDRAFT = Daylight
overdraft;

(6) INTRADAYSETTLEMNT =
Determination of intra-day and
final settlement positions;

(7) SECTRNS = Settlement of
securities transactions;

(8) CAPDSTBN = Transfer of
capital distributions and recurring
contractual payments;

(9) SUBSCREDEMNS =
Customer subscriptions and
redemptions;

(10) ESCFNDTRNSFR = Escrow,
funds transfer, stock transfer, and
agency

11) CUSTFNDDISTRBN =
Scheduled distribution of
customer funds;

(12) ESCFNDTRNSFRPAYSET =
Escrow, funds transfer, stock

transfer, and agency services,
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Sl. List of Seeded Tables Table/Entity Logical Table/Entity Descriptions

No. Names
including payment and settlement
services, payment of fees, taxes,
and other expenses; and
(13) FNDCOLL = Caollection and
aggregation of funds.

(14) OTH = Others

19 DIM_EXPOSURE_UNDERLYING_TYPE Exposure Underlying Type This table stores the various
underlying type for the exposures.

20 DIM_GAAP Generally Accepted This entity stores the details of

Accounting Principles Generally Accepted Accounting
Dimension Practice.

21 DIM_HOLDING_TYPE Holding Type Dimension This table stores the Holding Type
of the security.

22 DIM_INSTRUMENT_TYPE Instrument Type Dimension | This entity stores the details of all
instrument types that are
supported by Reveleus Market
Risk.

23 DIM_LCR_CAP_CASH_FLOWS LCR cap dimension This table stores the cap on cash
flows for liquidity reporting.

24 DIM_MATURITY_BUCKETS Maturity Bucket Dimension | This table stores the bucket
ranges for maturity dates of an
account.

25 DIM_METHODOLOGIES Methodologies Master This entity stores the different
methodologies available for
different applications.

26 DIM_OR_STATUS Operation Risk Status This table stores information

Dimension about Status like Open, Close,
Complete, and so on.
27 DIM_PRODUCT BOOK Product Book Dimension This table stores exposure details

whether it is Banking book or
Trading book (if info is not
available it is under Missing

category).
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Sl. List of Seeded Tables Table/Entity Logical Table/Entity Descriptions
No. Names
28 DIM_REG_CAP_EXEMPTION_CRITERIA | Regulatory Capital This table stores the various
Exemption Criteria exemption criteria as specified
Dimension under the regulatory capital
guidelines. This exemption criteria
is applicable for any exposures to
be exempted from the regulatory
calculation like leverage ratio or
large exposures. These criteria is
unique and is not overlapping for
the exposures in a specific run.
29 DIM_REG_CONSTITUTED_FORM Regulatory Dimension for This table stores the list of all
Company Constitution constituted forms of establishment
Form of an entity for various
jurisdictions like Joint stock,
Mutual/cooperative, Other non-
joint stock, and so on.
30 DIM_REG_DEPOSIT_TYPE Regulatory Deposit Type This table stores details of various
Dimension deposit types like Demand
deposits and NOW accounts.
31 DIM_REG_ENTITY_TYPE Regulatory Dimension for This table stores the list of all
Entity Type regulatory entity types to be
reported in various jurisdictions
like Universal banking,
Retail/commercial banking,
Investment banking, Specialised
lender, and so on.
32 DIM_REG_INSTR_CLASSIFICATION Regulatory Instrument This table stores data for different
Classification Instrument Classified defined by
Regulators.
33 DIM_REG_LOAN_PURPOSE Regulatory Loan Purpose This table stores the description

Dimension

for the regulatory loan purpose /
utilization of loan amount. Values
expected are:

1 = Purchase

4 = Rate / Term Refinance

5 = Cash-Out Refinance

6 = Other Refinance
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Sl.

No.

List of Seeded Tables

Table/Entity Logical
Names

Table/Entity Descriptions

7 = Home Improvement
8 = Debt Consolidation
9 = Education

A = Medical

Y = Other

U = Unknown

34

DIM_REG_PARTY_RELATIONSHP_TYPE

Regulatory Party
Relationship Type
Dimension

This table stores the relationship
types defined by the Regulators.
The table is used to determine the
regulatory relationship type
between two parties. This can
also be used for relationship type
between an entity and a party,
wherein the entity is represented.

35

DIM_REG_PRODUCT_CLASSIFICATION

Regulatory Product
Classification Dimension

This tables stores the
classification of loans underlying
Mortgage Servicing Rights into
Regulatory classes as required for
reports. Example: FHLMC/ FNMA,
FHA loans, and so on.

36

DIM_REG_PRODUCT_TYPE

Regulatory Product Type

This table stores regulatory
product types. This is used for
regulatory reporting purpose and
contains values like Auto Loans,
Credit Cards, other consumer
loans, and so on.

37

DIM_RISK_TYPE

Risk Type Dimension

This table stores the Risk Types.
For example: Price Risk, Volatility
Risk, and so on.

38

DIM_RISK_WEIGHT

Risk Weight Dimension

This table stores the various Risk
Weight assigned under Basel
Accord.
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Sl. List of Seeded Tables Table/Entity Logical Table/Entity Descriptions
No. Names
39 DIM_STANDARD_ACCT_HEAD Standard Accounting Head | This entity lists the various
Dimension standard accounting heads
(Equity, Reserves and Surplus,
and so on) under which a bank
classifies its GL sources of
accounting capital.
40 DIM_STANDARD_EVENT_TYPE Standard Loss Event Type | This entity stores the master list of
Dimension Operational Loss Event Types as
prescribed by the Regulator.
41 DIM_STANDARD_PARTY_TYPE Standard Party Type This table stores the standard
Dimension party type, party here could be
customer, issuer and guaranator,
and so on.
42 DIM_STANDARD_PRODUCT_TYPE Standard Product Type This table stores the list of all
Dimension product types specified by
regulator for risk computations.
43 DIM_STD_MITIGANT_TYPE Standard Mitigant Type This entity stores the standard
Dimension mitigant type.
44 DIM_TRADING_ACCT_BOOK_TYPE Trading Account Book Type | This table stores the trading
assets and liabilities. Along with
Holding type as held for trading at
times regulator has an additional
criteria like positive fair value for
identification of trading assets and
negative fair value for trading
liabilities.
45 DIM_UNDRLYNG_ASST_POOL_TYPE Underlying Asset Pool Type | This table stores the underlying

Table

asset pool type for derivative
instruments.

For example: Student Loan ABS
means an asset backed security
backed by student loans. In this
case, this table stores Student
Loan.
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Sl. List of Seeded Tables Table/Entity Logical Table/Entity Descriptions

No. Names

46 DIM_REG_FIXED_ASSETS Reg Fixed Assets This table stores the data related

Dimension to reg fixed assets. Reg fixed
assets are physical assets such
as Buildings, Land, Machinery,
Automobiles, Gold bullion, and so
on. They can be sold and
appropriate profit/loss can be
recognized based on appropriate
accounting principles.

47 DIM_REG_VALUATION_METHOD Regulatory Valuation This table stores the Regulatory
valuation method used to
calculate the mitigant value.

48 DIM_FV_CLASSIFICATION_TYPE Fairvalue Classification This table stores list of all the fair

Type For Dimension value option classification types.

49 DIM_CASH_FLOW_TYPE Cash Flow Type Dimension | This table contains the cash flow

types like principal, interest, and

SO on.
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3.1.10 Fact Tables/Entities

For all tables with data flow type tagged as a Processing, it is recommended that end users map data
directly to result area if processing application is not part of OFSAA product suite. For example, Basel
computations, RWA Numbers, and Capital Ratio are taken from processing area which is populated by

OFSAA or other Basel application.

For processed tables, you can look for the following options:
¢ OFSAA Data Integration Hub (DIH) product
¢+ Flat File

¢+ Table-to-Table Transformation with source being processing application

Table 7: Fact Seeded Tables/Entities

Sl. List of Seeded Tables Table/Entity Logical Table/Entity Descriptions Data Flow

No. Names Type

1 FCT_IFRS_ACCOUNT_SUMM Fact IFRS Account This table holds the measures Processing

ARY Summary related to account that are
computed by IFRS application.
2 FCT_COMMON_ACCOUNT_S Fact Common Account | This table stores common account | Staging
UMMARY Summary level information that usually
comes as an input through
staging.

3 FCT_CREDIT_LINE Fact Credit Facility This table stores the credit facility | Staging,
data. Credit facility is committed Processing
line of credit given to a customer
who can have multiple draws /
exposures out of a given credit
line.

4 FCT_CREDITRISK_ACCOUNT | Fact Credit Risk This entity captures different Staging

_SUMMARY Account Summary measures of exposures pertaining
to Credit Risk Analytics.
5 FCT_IFRS_MITIGANTS_SUMM | Fact IFRS Mitigants This table stores the IFRS Processing
ARY Summary mitigants summary.
6 FCT_LCR_CAP_WEIGHT_SPE | Fact Cap On Flows This table stores the inputs for cap | Processing
CS And Weight on cash flows and applicable

Specification For LCR | weight that is haircut, which is
used in Liquidity Coverage Ratio
reporting as stipulated in the
Delegated Act on Liquidity issued

by the European Commission.
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Sl. List of Seeded Tables Table/Entity Logical Table/Entity Descriptions Data Flow
No. Names Type
7 FCT_LEGAL_ENTITY_DETAIL Fact Legal Entity This table stores the legal entity Staging
S Details details.
8 FCT_LLFP_ACCOUNT_SUMM | Fact Loan Loss This entity stores loan loss Processing
ARY Forecasting And forecasting and provision account
Provision Account summary. This table is an input
Summary from loan loss forecasting and
provision (LLFP) application.
9 FCT_LRM_ACCOUNT_SUMMA | Fact LRM Account This table stores the Account Processing
RY Summary Derived details in Liquidity Risk
Management (LRM) solution.
10 FCT_LRM_ACCT_PLCD_COL_ | Fact LRM Account This entity stores the details of Processing
MAP Placed Collateral Map | account and the placed collateral.
11 FCT_LRM_PLACED_COLLATE | Fact LRM Placed This entity stores the LRM Placed | Processing
RAL Collateral Collateral details.
12 FCT_MGMT_REPORTING Fact Management This table stores management Processing
Reporting reporting data related to
organization and product
profitability / income statement /
balance sheet.
13 FCT_MITIGANT_REG_CAPITA | Fact Mitigant This table stores the regulatory Processing
L Regulatory Capital capital information related to
mitigants.
14 FCT_MITIGANTS Fact Mitigants This entity stores the consolidated | Staging
details of all the mitigants.
15 FCT_OPERATIONAL_LOSS Fact Operational Loss | This entity stores the Operational Staging
Losses as reported by the
Financial Institution or the
Operational Loss Data
Consortium.
16 FCT_OPSLOSS_DATA_THRES | Fact Operation Loss This table stores the threshold for | Staging
HOLD Threshold the operational loss recording for
a given combination of Line of
Business and every type.
17 FCT_PARTY_PARTY_RELATI Fact Party To Party This table stores the relationship Staging
ONSHIP Relationship between the parties.
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Sl. List of Seeded Tables Table/Entity Logical Table/Entity Descriptions Data Flow
No. Names Type
18 FCT_PLACED_COLLATERAL Fact Placed Collateral | This stores the details of collateral | Staging
which are placed against an
account.
19 FCT_REG_ACCOUNT_SUMMA | Fact Regulatory This table stores the regulatory Results
RY Account Summary reclassifications and other
information as required for
regulatory reporting.
Note:
Since the
F_NCA_DISPOSAL_GRP_FLAG
value is not directly available in
bank’s source system, this flag
must be updated separately post
stage data loading. The bank can
choose any method (that is, rule/
excel/ query population, and so
on) to populate this column.
20 FCT_REG_ACCT_MITIGANT_ Fact Regulatory This table stores the account Processing
MAPPING Account Mitigant mitigant mapping information.
Mapping
21 FCT_REG_AGG_CASH_FLOW | Fact Regulatory This entity stores the Aggregated Processing
S Aggregated Cash Cash flows for regulatory
flows reporting.
22 FCT_REG_CAP_ACCOUNT_S | Fact Regulatory This table stores regulatory capital | Processing
UMMARY Capital Account for each account. This table is an
Summary input from Basel application.
23 FCT_REG_CAP_PARTY_GRP_ | Fact Member Map for This table stores the mapping Processing
MMBR_MAP Party-Party between member and the group
Relationship head and the type of relation.
Members are determined from
both party dimension and party-
party relationship entity.
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Sl. List of Seeded Tables Table/Entity Logical Table/Entity Descriptions Data Flow
No. Names Type
24 FCT_REG_CAP_PLCD_COLL_ | Fact Regulatory This table stores the information Processing
SUMMARY Capital Placed of all exposures to a bank which
Collateral Summary are placed collateral. The placed
collateral are collateral placed by
the bank for either default fund
contribution or for other OTC
transactions, with a central
counterparty. It is generally used
for cleared transactions and
default fund contributions.
25 FCT_REG_LARGE_EXP_CP_LI | Fact Regulatory Large | This table stores the values of Processing
MITS Exposure Counter Large Exposure Limits.
Party Limits Details
26 FCT_REG_CP_CAPITAL_SUM | Fact Regulatory This table stores all the regulatory | Processing
MARY Counterparty Capital capital related information of a
Summary counterparty. Some of the risk
parameters in this table are
probability of default and internal
and external rating for the
counterparty. This table is
generally used for CVA
calculations and default fund
calculations.
27 FCT_REG_PLACED_COLLATE | Fact Regulatory This table stores the cash flow Processing
RAL Placed Collateral groups required for EBA
Reporting.
28 FCT_SIGNIFICANT_CURRENC | Fact Significant This table stores the significant Processing

Y

Currency

currency value. It is a currency
that is held in significant quantities
by governments and financial
institutions as part of their foreign
exchange reserves. This table is
used for LCR reports.
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Sl. List of Seeded Tables Table/Entity Logical Table/Entity Descriptions Data Flow
No. Names Type
29 FCT_SWAP_MITGT_PLCD_CO | Fact Collateral Swap This table stores the mapping Staging
LL_MAP Account Map for between the collateral lent and
Collateral Lent and mitigant received on a
Mitigant Received proportionate basis for a Collateral
Swap account.
30 FCT_LOAN_ACCOUNT_SUMM | Fact Loan Summary This table stores the details of Staging
ARY loans. This table includes
mortgage, vehicle loans.
31 FCT_FIXED_ASSETS Fact Fixed Assets This fact table stores measures Staging
pertaining to assets. Fixed assets
are physical assets such as
Buildings, Land, Machinary,
Automobiles, Gold bullion etc.
They can be sold and appropriate
profit/loss can be recognized
based on appropriate accounting
principles.
32 FCT_ACCOUNT_MITIGANT_M | Fact Account Mitigant Processing entity to capture Staging
AP Map account to mitigant mapping. It
supports more than one mitigant
to be mapped to an account.
33 FCT_ACCT_FAIRVALUE_ATTR | Fact For Fair Value This fact table stores the FV gain Processing
IBUTION Gain Loss Values loss value taken to equity or
profit/loss.
34 FCT_ACCT_PLACED_COLL_M | Fact Account Placed This table stores account to Staging

AP

Collateral Map

placed collateral mapping. It is an
intersection table to denote a
placed collateral can be used in
multiple account & an account

contains multiple collateral.
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Sl. List of Seeded Tables Table/Entity Logical Table/Entity Descriptions Data Flow
No. Names Type
35 FCT_REG_FIXED_ASSETS Fact Reg Fixed Assets | This fact table stores measures Processing

pertaining to the assets required
for regulatory reporting. Fixed
assets are physical assets such
as Buildings, Land, Machinary,
Automobiles, Gold bullion etc.
They can be sold and appropriate
profit/loss can be recognized
based on appropriate accounting
principles.

36 FCT_REG_RUN_LEGAL_ENTI | Fact Regulatory Legal | This table stores reporting entity Processing
TY_MAP Entity Run Map identifier for every regulatory

reporting run.

3.2 Mapping of Results to Reporting Requirements of Lombard Risk

Figure 25 explains the flow of data between OFSAA and AgileREPORTER.
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Figure 25: Data Flow between OFSAA and AgileREPORTER

OFSAA provides the data to AgileREPORTER in the form of derived entities. Derived entity is an existing
OFSAA higher order metadata object and can be physicalized as a materialized view in the database.
Derived entities store aggregated data from base fact entities specified in the dataset and have the
necessary dimensions and measures.
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Dimensional and measure combination stored within the derived entity is mapped to cells within the
report. This mapping is maintained within the ‘Dimensional mapping’ template. ‘Decision Process’ within
AgileREPORTER reads the derived entities and dimension mapping information to derive the data for
reporting. Derived entities are created based on measures, hierarchies, and datasets.

Decision Agile
Process REPORTER

Figure 26: Decision Process in AgileREPORTER

Some cells in the schedule can be derived as per the logic provided by the regulator. Derivation can be
an expression built using values from other cells. Examples of derivation are ratio, node-level rollup,
direct reference to cells in other schedules within the report. These derivations are performed within the
AgileREPORTER. OFSAA provides data only for the cells that are not derived.

Note: Metadata for data transformation is available as part of the data ware house configuration pack
provided Out-of-Box / pre-configured from OFSAA. You need not perform any mapping for the reports.
However, this information can be useful for maintenance or extensions when Out-of-Box pack is not
available.

3.3 AgileREPORTER: Submission

The AgileREPORTER is a web-based regulatory reporting tool provided by Lombard Risk. It provides
necessary features to address e-filing workflow, validation and submission process, and supports reports
(called as forms/returns) for various jurisdictions. AgileREPORTER provides a reliable and efficient
infrastructure to compile, generate, and submit regulatory reports.
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4 OFSAA Features

This chapter provides an understanding of the AAI components used in the solution and dimensional
mapping. It includes:

¢ OFSAA Infrastructure

¢ Business Metadata

¢ Derived Entity
¢ Rules Run Framework Features

¢ Dimension Mapping

Regulatory Reporting Solution (RRS) configures the data hand off structure to Lombard using metadata.
The following sections provide details on datasets, measures, hierarchies and Derived Entities. Multiple
derived entities are linked to a specific regulatory schedule. You can modify the configuration using
OFSAA infrastructure. Additionally, metadata route provides traceability from reporting elements to the
data elements used.

4.1 OFSAA Infrastructure

OFSAA Infrastructure includes the facilities for creating and maintaining dimensional reference data,
interest rate and currency exchange rate data, and process tuning data. Additionally, OFSAA
Infrastructure includes functionality for building and maintaining rules that can be used by any Oracle
Financial Services Analytical Application. These common rule objects include:

¢ Expressions
¢ Hierarchies
¢ Filters

The analytical applications that you see on the Left Hand Side (LHS) of the Financial Services
Applications home page depends on your logon privileges and on the OFSAA modules that are installed
for your environment.
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Figure 27: Landing Page

4.2 Business Metadata

In addition to Derived Entity, RRS uses the following OFSAA features to create the business metadata.
For details on the features, see OFS Analytical Applications Infrastructure User Guide in OHC
documentation library.

¢+ Hierarchies: Some OFSAA dimensions support hierarchies. Hierarchies can be used to provide
sophisticated stratification for either processing or reporting purposes. For example, an
organizational hierarchy can start with a Division level containing Western Region, Eastern
Region, and Southern Region; the next level down within the hierarchy can be state or county. A
product hierarchy can begin with branches for Asset vs. Liability vs. Service products; under the
Asset branch, you can define additional branches for Mortgage Lending, Commercial Lending,
Consumer Lending, and so on.

¢ Measures: Business Measure refers to a uniquely named data element of relevance which can
be used to define views within the data warehouse. It typically implies aggregated information as
opposed to information at a detailed granular level that is available before adequate
transformations.

¢ Business Processor: It refers to a uniquely named data element of relevance which can be used
to define views within the data warehouse. It typically implies aggregated information as opposed
to information at a detailed granular level that is available before adequate transformations.

¢+ Datasets: It refers to a group of tables whose inter-relationship is defined by specifying a join
condition between the various tables. It is a basic building block to create a query and execute on
a data warehouse for a large number of functions and to generate reports.
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4.3 Derived Entity

It is the primary component of OFSAA used for OFSDF Interface with Lombard Risk for EBA. Regulatory
Reporting Solution uses Derived Entity to create physical materialized view which is then queried by
Lombard using pre-set data hand-off templates. An Entity refers to a table in which data is stored. Derived
Entity within the infrastructure system facilitates you to define entities which are populated through a
series of data transformation processes resulting from an existing Data Set or a Source Application. An
Entity can be used to define other Business Metadata such as measures, hierarchies, dimensions, data
sets, and cubes.

Derived Entities comprise the following:
¢ Measures
¢ Hierarchies
¢ Datasets

Ensure to define the above components within OFSAA before configuring the derived entity, and select
Materialized View property in Derived Entity. This property creates the derived entity as materialized
views.

1. Navigate to path Financial Services Data Foundation - Unified Analytics Metadata 2

Business Metadata Management - Derived Entity. The existing derived entities summary
screen is displayed. You can Add a new derived entity and Edit, View, Delete, or Copy an existing

derived entity.

ORACLE Financial Services Analytical Applications

B v A v | usengishv

OFSAD v

Object System Configuration & Identity
eisctpeRcalions) Financial Services Data Foundation > Unified Analytical Metadata > Business Metadata Management > Derived Entity
Financial Services Data Foundation v
A
4 [ Financa Seces Dt Foundstion Summary Screen @
» & Data Model Management Search and Filter O, Search 4 Reset
» B pata Management Framework
B Code Source Type -
4 [E] unified Analytical Metadata
» [@ Dimension Management Short Description Authorized O
4 [ Business Metadata Management
B i
= Derived Entity
% Derived Entity
& pataset B Edit Wl View ' Delete Copy Search
& Measure
Buid Hierarchy O code Short Description Long Description Creation Date Source Type Material
e [ DERROOL DE - Reg Account Summary DE - Reg Account Summary Sat Jul 01 09:56:26 IST 2017 Dataset Yes
[ Business Processor [] DERROOZ DE - Management Reporting YTD...  DE - Management Reporting YTD...  Thu Aug 10 00:00:00 IST 2017 Dataset Yes
A wiap Maintenance [] DERROO3 DE - Management Reporting QTD...  DE - Management Reporting QTD...  Sat Jul 01 09:56:26 IST 2017 Dataset Yes
B Expression [ DERROD4 DE - Management Reporting MTD...  DE - Management Reporting MTD...  Sat Jul 01 09:56:26 IST 2017 Dataset Yes
0 Fiter [] DERROOS DE - Reg Account YTD Metrics DE - Reg Account YTD Metrics $2t Jul 01 09:56:26 IST 2017 Dataset Yes
B save Metadata [] DERRO0S DE - Reg Account QTD Metrics DE - Reg Account QTD Metrics Sat Jul 01 09:56:26 IST 2017 Dataset Yes
» W Analytics Metadata [0 DERROO7 DE - Reg Account MTD Metrics DE - Reg Account MTD Metrics sat Jul 01 09:56:26 IST 2017 Dataset Yes
¥ & Rule Run Framework [] DERRO08 DE - Reg Capital Account Summary  DE - Reg Capital Account Summary ~ Sat Jul 01 09:56:26 IST 2017 Dataset Yes
» & Run Management [] DERRO0Y DE- Counterparties Large Exposure... DE- Counterparties Large Exposure... SatJul 01 09:56:26 IST 2017 Dataset Yes
L %Owa"m [0 DERROIO DE- Counterparties Individual DE- Counterparties Individual Sat Jul 01 09:56:26 IST 2017 Dataset Yes
» [ setings
¢ [ DERROIL DE- Counterparties Large Exposure... DE- Counterparties Large Exposure... Sat Jul 01 09:56:26 IST 2017 Dataset Yes
8B wetacata Browser
[] DERROIZ DE - Management reporting EOP B.. DE - Management reporting EOP B... Sat Jul 01 09:56:26 IST 2017 Dataset Yes
[ DERROI3 DE - Management Reporting EOP..  DE - Management Reporting EGP..  Sat Jul 01 09:56:26 IST 2017 Dataset Yes
[ DERRO14 DE - Reg Account Summary BOY  DE - Reg Account Summary BOY  Sat Jul 01 09:56:26 IST 2017 Dataset Yes v

Figure 28: Derived Entity Summary Screen
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2. Click the Add button to create a new Derived Entity.

B v A v | usengsnv | oFsapv

ORACLE Financial Services Analytical Applications

Applications | Object Adminisiration ~ System Configuration & Identity Management

Select Applications Financial Services Data Foundation > Unified Analytical Metadata > Business Metadata Management > Derived Entity

Financial Services Data Foundation v

4 [ Fnencial Services Dt Foundaion Derived Entity Details
» B pata Mode! Management Derived Entity Details 4 Reset
» [EB Data Management Framework .

Bl Code Application Name

4 Unified Analytical Metadata

b et * Short Description Source Name
4 [ Business Metadata Management
Q@ aras Long Description Refresh Interval
@ Derived Entity
B pataset
3B Measure
Build Hierarchy

* Source Type Dataset v Refresh Method
Aggregate Enable Query Rewrite

@ Dimension Materialize View Parallelism
i Business Processor
@]Map Maintenance DataSet Name v Hint

Eil Expression

[ Fitter Metadata Tree g Save  Eg Close

% Save Metadata
» b Analytics Metadata

» B8 Rule Run Framework =

Available Values Selected Values

» 2 Run Management

» [ operations

» B settings ~
[ Metadata Browser

Figure 29: Derived Entity User Interface

Derived Entities must have Code, Short Description and Source Type as mandatory dimensions. Rest
of the structure of the derived entity can vary depending on the dimensions present. A metadata
configuration table is present in AgileREPORTER to link the name of the column in the derived entity and
dimension that is referred in dimension mapping process.

Derived entities have data for the ‘Final Reporting Run’ only, which is reported to the Regulatory, and are
refreshed for the latest hand-off date.

A metadata configuration table is maintained within AgileREPORTER to capture the derived entities that
supply data for each schedule.

4.3.1 Creation of Derived Entity

Refer to OFS Analytical Applications Infrastructure User Guide in (OHC) documentation library for
detailed steps on creating a derived entity.

4.3.2 User Roles

Following are the user roles for derived entity:

¢+ Reporting Analyst: This user can create, modify, and delete a derived entity.

¢+ Data Analyst: This user can view the derived entities.
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4.4 Rules Run Framework Features

OFSDF Interface with Lombard Risk for EBA uses the following Rules Run Framework of OFSAA. For
details on the features refer to OFS Analytical Applications Infrastructure User Guide in OHC
documentation library.

¢ Rules: Financial institutions require constant monitoring and measurement of risk in order to
conform to prevalent regulatory and supervisory standards. Such measurement often entails
significant computations and validations with an organization’s data. Data must be transformed to
support such measurements and calculations. The data transformation is achieved through a set
of defined Rules.

RRS uses Rules for reclassification of dimensions.

¢ Process: A set of Rules collectively form a Process. A Process definition is represented as a
Process Tree. The Process option in the Rules Run Framework provides a framework that
facilitates the definition and maintenance of a Process. By defining a Process, you can logically
group a collection of Rules that pertain to a functional process.

¢ Run: The Run feature in the Rules Run Framework helps you to combine various components
and/or processes together and execute them with different underlying approaches. Further, run
conditions and/or job conditions can be specified while defining a run.

4.5 Dimension Mapping

Each cell reference is mapped to a set of dimensions and measures. This mapping is documented in
excel and then converted to a Decision table through an offline utility provided by AgileREPORTER.
Decision table is a metadata object within AgileREPORTER that stores the criteria for deriving value for
each cell reference. The metadata is packaged for regulatory report as part of the OFS Risk Regulatory
Solution. Decision table process within AgileREPORTER reads the metadata and derived entity published
by OFSAA to populate data required for returns for the specified date and legal entity.

The following table is an example of dimension mapping. Each cell reference is mapped to a set of
dimension members and measure. If a dimension is left empty for a cell reference, it indicates that it is not
participating in the mapping process. If there are multiple mappings for a cell reference, then the value of
this cell can come from any of these criteria.

Decision mapping table is processed against the contents of derived entity to reporting data. Each record
of the derived entity is matched against the criteria specified in the decision table to identify the cell
reference and derive return data (such as, cell reference and cell value).

NOTE: Note: All the dimension member codes that are used in the decision table are preseeded by
OFSAA and cannot be modified. Therefore, if you have other member codes in the dimension,
then you must re-classify them by using re-classification rule post load, or value-code mapping
during load.
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Decision tables must be prepared closer to the report submission period. In some cases, reclassification
of multiple dimensions which result in a single unified reporting dimension must be performed in order to
address the complexity of decision table. Reclassification rule is defined in OFSAA and packaged as part
of OFSAA Risk Regulatory Reporting Solution.

In some cases, certain sections of the schedule or the entire schedule can be a list of data rows without
any mapping to fixed set of dimension members. For example, Top 20 counterparties, List of Available for
Sale (AFS) - securities. In such cases, since there are no cell references, decision table mapping
specifies the names of dimensions and measures of derived entities in ‘sheet’ column or ‘row’ column of
the template.

NOTE: As a part of the solution, metadata exists as out of box / pre-configured with installer.
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5 Executing Run through Run Management

Starting from OFSDF 8.0.3.1.0 release, we are packaging two out-of-the-box Runs for data loading.
Same can be executed through the Run Management screen. The following are the two runs that are
packaged as part of Installer.

¢+ Financial Services Data Foundation Sourced Run: This Run can be executed once per day for
Data Movement from Staging Area to Results Area for Non-RUN SKEY tables.

¢ OFS REG REP EBA Run: This Run can be executed any number of times per day with each

unique RUN SKEY for Data Movement in Run enabled tables.

5.1 Summary and Details Page

Upon initially navigating to Run Management - Run Management, a summary page is displayed
showing all the defined Runs. By selecting a Run or by using search criteria, you can control the set of
Runs that are displayed. This page displays the list of runs defined in the Run Rule Framework (RRF)
except those with Immediate Execution Option Yes in the grid.

5.2 Navigation within the Summary Page

When you first navigate to the Run Management summary page, the Runs defined in the RRF are
presented in a summary grid. The Run Management summary page has two sections:

¢ Search

¢ List of Runs

5.2.1 Search Section

Among other properties, each Run possesses a segment, a Run Name, and a Run Type. You may
search on any of these properties in the Search section.

B v A v | usengisnv | oFsaDv

ORACLE’ Financial Services Analytical Applications

Object System € & Identity

Select Applications

Financial Services Data Foundation > Run > Run
Financial Services Data Foundation v

4 (B Financial Services Data Foundation Run Management Summary

» B Data Model Management = |

» EB Data Management Framework
4 [& unified Anaiytical Metagata

‘]

» @l Dimension Management Run Type
» [ Business Metadata Management
b b Anaiytics Metadata
. % List of Runs Fito20f2
» [ Ruie Run Framework
Run Name Run Type Created By Created Date Last Modified By Last Modified Date v
EBA Regulatory Reporting Run BASELINE RUN SYSADMN 117302016 SYSADMN 12/16/12016
% Run Management O EBA Source Base Run BASELINE RUN SYSADMN 1211672016 - -
» [ operations
» & settings
B metadata Browser

4 P8 Run Management &

Figure 30: Run Search Section
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5.2.2 List of Runs Section

The List of Runs section presents a grid containing all of the Runs that meet your search criteria. This
summary grid offers several icons that allow you to perform different functions when a Run is selected.

To select a Run, click the check box in the first column of the grid.

B v & v | usengisnv | OFsaDv

ORACLE Financial Services Analytical Applications

Applications | Object Administration ~ System Configuration & Identity Management

Select Applications

Financial Services Data ion > Run ? Run
Financial Services Data Foundation v

4 [@ Financial Services Data Foundation RurnlManzoEmentiSummary)

» B Data Model Management o & l
» Data Management Framework
Segment EBASEG v Run Name
4 E’ Unified Analytical Metadata
» (8] pimension Management Run Type
» ES Business Metadata Management
» b Anaiytics Metadata —
2 List of Runs | B RR& | F11020f2
» B8 Rule Run Framework
@ Run Name Run Type Created By Created Date Last Modified By Last Modified Date 7
4 &1 Run Management W | EBA Regulatory Reporting Run BASELINERUN | SYSADMN 113072016 SYSADMN 1211612016
& Run Management [] | EBA Source Base Run BASELINERUN | SYSADMN 127162016 -
» [& operations
» @Seltmgs

\ﬂ Metadata Browser

Figure 31: Run Selection

¢ View (E): Selecting a single row out of the grid enables you to view the detailed definition of a
Run on a read-only basis. The View icon is only enabled when a single Run is selected.

¢ Run Default Parameters ( =‘£): Selecting a single row out of the grid enables you to define the
default parameters of a Run.

¢ Run Execution Parameters (CF): Selecting a single row out of the grid enables you to define
the execution parameters of a Run.

¢ Run Execution Summary (B): Selecting a single row out of the grid enables you to view the

status of the Run executed in the Run Execution parameters window.

5.2.2.1 List of Runs Summary Grid

The following columns categorize each Run in the summary grid:
¢ Run Name: Displays the short name of the Run.
¢ Run Type: Displays the type of Run, Simulation or Baseline Run.
¢ Created By: Displays the name of the User who defined the Run.
¢+ Creation Date: Displays the date on which the Run was created.

¢+ Last Modified By: Displays the name of the user who has performed any modifications to the
Original Run details.

¢+ Last Modified Date: Displays the date on which the Original Run details were modified.
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5.2.3 Navigation within Run Default Parameters Window

Click Run Default Parameters icon on the navigation bar of the Run Management Summary Window to
input the Run level parameters. The Run Parameters Window is displayed.

Financial Services Data Foundation ¢ Run Management ¢ Run Management
L Run Details

Run Name EBA Regulatory Reporting Run

% gl Run Execution Parameters

Reporting Cumrency *

Legal Entity

Consolidation Type [Consclidated v

Consolidation Hierarchy

Figure 32: Run Default Parameters Window

NOTE: To modify or view the parameters the Modify Run Parameters role should be mapped to that
relevant user profile.

This window consists of two sections Run Details and Run Execution Parameters.

5.2.3.1 Run Details Section

This section displays the name of the Run which is a read-only value.

5.2.3.2 Run Execution Parameters Section
In this section, you can update the following:

¢ Reporting Currency: Reporting Currency Code parameter is used for calculation of amounts in
Reporting Currency during Data Population.

¢ Legal Entity: Legal Entity Code parameter is used for identifying the legal entity, which is used
for the Run.

¢+ Consolidation Type: Consolidation Type parameter is used for selecting legal entities on a solo
or consolidation basis. In a solo run, only the selected legal entity will be used. In a consolidated
run, along with the selected legal entity, all its child legal entities are also used.
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¢+ Consolidation Hierarchy: Legal Entity Hierarchy is used for selecting the required hierarchy for
the consolidated run. This parameter is not required for solo run.

Before proceeding further, to ensure that you do not lose the updated data, click Save.

NOTE: To get the values for Reporting Currency parameter and Legal Entity parameter, you need to
save the following hierarchies under Save Metadata screen:

¢+ Legal Entity Code for Run (HSFDF001)
¢ Reporting Currency Code for Run (HSFDF002)

¢+ Legal Entity Hierarchy for Run (HSFDF003)

NOTE: For further details on Save Hierarchy, refer to Oracle Financial Services Advanced Analytical
Applications Infrastructure Application Pack 8.0.5.0.0 on OHC.

The values selected for reporting currency and Legal entity for the selected Run is shown as the default
selected value in the Run Execution Parameters screen.

5.2.4 Navigation within Run Execution Parameters Window

Click Run Execution Parameters icon on the navigation bar of the Run Management Summary window.
The Run Execution Parameter window allows you to enter and save the Run execution parameters.

% gl Run Details

Run Mame EBA Regulatory Reporting Run

% gl Run Execution Parameters
Reporting Currency * E]
Legal Entity E]
Consolidation Type G i hd ‘
Consolidation Hierarchy E]
FIC MIS Date * ﬂ
Run Execution Description

| Save | | Execute ‘ ‘ Close |

A Audit Panel

Created By SYSADMMN Created Date 117302016

Last Modified By SYSADMN Last Modified Date 12116/2016

Figure 33: Run Execution Parameters Window

The Run Execution Parameters window consists of two sections Run Details and Run Execution
Parameters.
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524.1

Run Details Section

This section displays the name of the Run which is a read only value.

524.2

Run Execution Parameters Section

The following Run execution parameters can be updated:

¢

Reporting Currency: Reporting Currency Code parameter is used for calculation of amounts in
Reporting Currency during Data Population.

Legal Entity: Legal Entity Code parameter is used for identifying the legal entity, which is used
for the Run.

Consolidation Type: Consolidation Type parameter is used for selecting legal entities on a solo
or consolidation basis. In a solo run, only the selected legal entity will be used. In a consolidated
run, along with the selected legal entity, all its child legal entities are also used.

Consolidation Hierarchy: Legal Entity Hierarchy is used for selecting the required hierarchy for
the consolidated run. This parameter is not required for solo run.

FIC MIS Date: Enter the extraction date in this field.

Run Execution Description: Enter a longer description of the Run.

NOTE:

To get the values for Reporting Currency parameter and Legal Entity parameter, you need to
save the following hierarchies under Save Metadata screen:

Legal Entity Code for Run (HFSDF001)

Reporting Currency Code for Run (HFSDF002)

By clicking the Save button; a batch with the defined Run execution parameters is created. The batch

created

can be executed from the Batch Execution screen.

By clicking the Execute button, a batch with the defined Run execution parameters is created and
executed immediately. Status of the executed run can be seen in Batch Monitor screen or Run Execution

Summary page.

NOTE:

For further details on Save Hierarchy and Batch Execution, refer to Oracle Financial Services
Advanced Analytical Applications Infrastructure Application Pack 8.0.5.0.0 on OHC. To execute
a Run, the execute run role should be mapped to your user profile. Currently, the users
mapped under FSDF Admin or FSDF Operator User Groups automatically have this role.
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5.2.5 Navigation within Run Execution Summary Page

Select a Run from the Run Management Summary page and click Run Execution Summary icon to
display the Run Execution Summary page where the following sections are displayed.

Figure 34: Run Execution Summary

This section consists of the two sections Run Execution Summary and Run Execution Details.

5.2.5.1 Run Execution Summary Section

The Run Execution Summary displays the following details:
¢ Run Name: Displays the name of the Run.
¢ Run Type: Displays the type of Run, Baseline or Simulation.

¢ Run ID: Displays the Run Execution ID.

5.2.5.2 Run Execution Details Section

The Run Execution Details section presents a grid containing all of the executions of Run and status of a
particular execution of the Run. The menu bar in this grid offers several icons that allow you to perform
different functions when a Run Execution is selected. To select a Run Execution, click the check box in
the first column of the grid. More than one Run Execution can be selected at a time but this will cause
some of the icons to become disabled.

¢+ Parameter details: Click this icon to view the Run execution and Run default parameter details in
read-only mode.

¢ Copy: Click Copy icon, to copy the parameters as defined in the Run Execution Parameter
window to create a new batch.

¢+ Execute: Click Execute icon to trigger the batch which has been created from the Run Execution
Parameter window. The status of the triggered batch is displayed. In the Execution Summary
page, multiple selections of the execution IDs are available to trigger a batch.
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Request Report Flag: To request for a Report Flag, select a Run Execution ID in the Run
Execution Summary page and click Request for Reporting Execution icon. A dialog box
appears to input your comments. Click Submit and the status of this Run is displayed in the
Report Flag section. Only a successful execution can be requested for reporting. For the selected
Run and Execution date, there can be only one reporting flag.

Override Report Flag: Any reporting execution can be overwritten with another execution. Select
a successfully triggered batch in the Run Execution Summary page. The Override Report Flag
icon is enabled, if an execution is already marked as a Report Flag. You can override the
execution by updating your comments. This should be approved by the approver and the
procedure is similar to the procedure detailed in the Approve Report Flag section.

Approve Report Flag: After submitting the Reporting Run in the earlier section, the Approve
Report Flag icon is enabled. After clicking the icon, a dialog box with the User Comments and
Approver Comments is displayed. The Approver can update the comments in the Approver
Comments field and then click Approve or Reject button accordingly.

5.25.3 Run Execution Grid

The Run Execution Details displays the following details:

¢

¢

Run Skey: Displays the Run Skey of an individual execution.

Run Execution ID: Displays the execution ID of the Run.

FIC MIS DATE: Enter the extraction date in this field.

Execution Status: Displays the status of the execution which is failed or complete.
Execution Date: Displays the date when the Run was executed.

Time of Execution: Displays the time when the Run was executed.

Report Flag: Displays the flag type used when the Run was executed.
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6

Metadata Export Utility

The Metadata Export Utility helps the user to export OFSAA metadata into Excel Sheet. This feature
helps to get a view of OFSAA metadata and its dependencies. It is a template based approach where-in
user creates templates and selects Metadata Objects that need to be extracted. The extraction process is
supported only for Excel Sheet. While defining the template, user is expected to have prior knowledge of
the OFSAA Metadata objects that are relevant from his application point of view.

6.1

Prerequisites

The following executions must be performed before using the Metadata Export Utility:

1.
2.
3.

MDB Publish: Execute the batch, INFODOM_MDB

Logs: MDB logs are generated under deployed area /Context_Name/logs/MDB_XXXX.log
Data Elements Wrapper Execution: After MDB Publish is completed successfully with message
“Metadata publishing is finished.” in the /Context_Name/logs/MDB_XXXX.log, you must
execute the Data Elements Utility with the following seeded batch to get the Data Lineage for
each Metadata in OFSAA:

<INFODOM>_POP_DATA_ELEMENTS_EBA

NOTE: This execution requires adequate tablespace. Ensure that your Atomic Schema is
having enough tablespace in TEMP and USERS.

Parameters used in DATA_ELEMENTS Batch
The batch can be executed in different modes according to each requirement. The following are
the parameters used for executing the batch.

You can edit the parameters by accessing the Batch Maintenance screen.

a. Login to Oracle Financial Services Analytical Applications interface with your credentials.
Navigate to Applications - Financial Services Data Foundation > Operations - Batch
Maintenance

c. Select Batch Name (<INFODOM>_POP_DATA_ELEMENTS_EBA)

Select Task1 and click the Edit button. The EditTask Definition Window is displayed.
Modify the Parameter List field as applicable.

NOTE: The values must be in single quotes and comma separated for each value.
Follow the same order as in this table.

Sl. No. | Parameter Description List of Values Default Value
1 P_METADATA_FLAG Metadata Parser Flag | Y/N Y’
2 P_REPORT_FLAG Report Parser Flag Y/N Y’
3 P_MDR_USAGE_FLAG | Usage Parser Flag Y/N ‘N’
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Sl. No.

Parameter

Description

List of Values

Default Value

P_MDR_MD_DF_FLAG

Metadata to Data
Flow Flag

Y/N

‘N

P_INFODOM_NAME

Infodom Name

##INFODOM##

<Value of the
Infodom where
EBA is
installed>.

For example:
‘EBAINFO’

P_SEGMENT_CODE

Segment Code

#H#SEGMENT##

<Value of
Segment Code
which is used
while installing
EBA>.

For example:
‘EBASEG’

P_REG_APP_ID

Application Identifier

##APPID##

Application ID for
EBA.

For example:

‘OFS_REG_REP
_EBA’

¢+ Metadata Parser Flag (P_METADATA_FLAG): By enabling this flag, the data
elements utility parses all the Business Metadata like Business Hierarchies, Business
Measures, Business Processes, Derived Entities, Datasets, Aliases and its lineage
between them. It also parses Data Flow Metadata like T2Ts, SCDs, Rules, and the
lineage between them.

¢+ Report Parser Flag (P_REPORT_FLAG): By enabling this flag, the data elements
utility parses all the Dashboards, Reports, Schedules, Views, and join these outputs
with the Metadata which are already parsed through the Metadata Parser Flag
(P_METADATA_FLAG).

NOTE:

Even if this flag is enabled, the Dashboards which get parsed depend on

the FSI_DE_POP_REPORT_LIST table in Atomic Schema. By default, all
Dashboards are enabled and if you wish to parse particular Dashboards,
modify the FSI_DE_POP_REPORT_LIST table by enabling / disabling the
“Include Report Column”. The following are the default Dashboards

packaged.
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Sl. No.| DASHBOARD ID | REPORT CODE JURISDICTION CODE | INCLUDE
REPORT
1 5001 F10200 EBA Y
2 5002 F10405 EBA Y
3 5002 F10404 EBA Y
4 5002 F10403 EBA Y
5 5002 F10402 EBA Y
6 5002 F10401 EBA Y
7 5003 F10700 EBA Y
8 5004 F10802 EBA Y
9 5004 F10801 EBA Y
10 5005 C30.00 EBA Y
11 5005 C29.00 EBA Y
12 5005 C28.00 EBA Y
13 5005 C27.00 EBA Y
14 5005 C26.00 EBA Y
15 5005 C31.00 EBA Y
16 5006 F10500 EBA Y
17 5007 F10600 EBA Y
18 5008 F10901 EBA Y
19 5008 F10902 EBA Y
20 5009 C17.00 EBA Y
21 5010 F11400 EBA Y
22 5011 F11000 EBA Y
23 5012 F11101 EBA Y
24 5013 F11302 EBA Y
25 5013 F11303 EBA Y
26 5013 F11301 EBA Y
27 5014 F11900 EBA Y
28 5015 C07.00 EBA Y
29 5016 C72.00 EBA Y
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Sl. No.| DASHBOARD ID | REPORT CODE JURISDICTION CODE | INCLUDE
REPORT

30 5016 C74.00 EBA Y
31 5016 C75.00 EBA Y
32 5016 C73.00 EBA Y
33 5017 F12007 EBA Y
34 5017 F12002 EBA Y
35 5017 F12001 EBA Y
36 5017 F12003 EBA Y
37 5017 F12004 EBA Y
38 5017 F12005 EBA Y
39 5017 F12006 EBA Y
40 5018 F11604 EBA Y
41 5018 F11605 EBA Y
42 5018 F11601 EBA Y
43 5018 F11603 EBA Y
44 5018 F11602 EBA Y
45 5018 F11606 EBA Y
46 5018 F11607 EBA Y
47 5019 F11800 EBA Y
48 5020 C47.00 EBA Y
49 5020 C44.00 EBA Y
50 5020 C43.00 EBA Y
51 5020 C40.00 EBA Y
52 5020 C41.00 EBA Y
53 5021 F10101 EBA Y
54 5021 F10102 EBA Y
55 5021 F10103 EBA Y
56 5022 FI1701 EBA

57 5022 F11703 EBA

58 5022 F11702 EBA Y
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Sl. No.| DASHBOARD ID REPORT CODE JURISDICTION CODE | INCLUDE
REPORT
59 5023 FI2100 EBA Y
60 5024 F14102 EBA Y
61 5024 Fl4103 EBA Y
62 5024 Fl4101 EBA Y
63 5025 FI14200 EBA Y
64 5026 FI4300 EBA Y
65 5027 F14600 EBA Y
66 5028 F14503 EBA Y
67 5028 Fl14502 EBA Y
68 5028 Fl4501 EBA Y
69 5029 FI0300 EBA Y
70 5030 FI3002 EBA Y
71 5030 FI3001 EBA Y
72 5031 FI3101 EBA Y
73 5031 FI3102 EBA Y
74 5032 Fl4403 EBA Y
75 5032 Fl4401 EBA Y
76 5032 Fl4402 EBA Y
77 5033 FI2202 EBA Y
78 5033 FI2201 EBA Y
NOTE: After the Metadata Parsing is completed and if there are no further

changes in Business Metadata and Data Flow Metadata, you can execute
the batch by disabling the Metadata Parser Flag (P_ METADATA_FLAG).
Now the Metadata is not parsed again, but the Report newly enabled
through FSI_DE_POP_REPORT _LIST table is parsed.

If there is a change in Business Metadata and Data Flow Metadata, you
need to enable the Metadata Parser Flag (P_METADATA_FLAG) and
parse once again.

¢ Usage Parser Flag (P_MDR_USAGE_FLAG): By enabling this flag, the data elements
utility parses all the Entities and joins these outputs with the Metadata which are
already parsed through Metadata Parser Flag (P_ METADATA_FLAG).
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¢ Metadata to Data Flow Flag (P_MDR_MD_DF_FLAG): By enabling this flag, the data
elements utility joins all the Business Metadata parsed output with Data Flow
parsed output for all applications.

¢ Infodom Name (P_INFODOM_NAME): This is the value of the Infodom where
OFS_REG_REP_EBA is installed. No need to modify this value.

¢ Segment Code (P_SEGMENT_CODE): This is the value of the Segment Code which is
used while installing OFS_REG_REP_EBA. No need to modify this value.

¢ Application Identifier (P_REG_APP_ID): This is the application identifier of the
product (OFS_REG_REP_EBA). No need to modify this value.

6.1.1 Verifying Logs

Data Elements logs are generated in Atomic Schema under the FSI_MESSAGE_LOGS table.

Flag

Batch Run ID

Indication

P_METADATA_FLAG

METADATA_ELEMENTS

Processes Business Metadata.

The message “Completed Over ALL
Metadata” indicates that the Business
Metadata parsing is complete.

P_METADATA_FLAG

ULTIMATE_METADATA_ELEME
NTS

Calculates Ultimate Table/Column for
Business Metadata.

The message “Completed
ULTIMATE_METADATA_ ELEMENTS”
indicates that the Business Metadata

Ultimate elements parsing is complete.

P_METADATA_FLAG

DATA_FLOW_ELEMENTS

Processes Data Flow Metadata.

The message “Completed Elements for
DATA_FLOW_ELEMENTS” indicates that
the Data Flow Metadata parsing is
complete.

P_METADATA_FLAG

ULTIMATE_DATA_FLOW_ELEM
ENTS

Calculates Ultimate Source Table/Column
for Data Flow Metadata.

The message “Completed
ULTIMATE_DATA FLOW_ELEMENTS”
indicates that the Data Flow Metadata

Ultimate elements parsing is complete.

P_METADATA FLAG

POP_MDR_LINEAGE_METADAT
A

Links Data Flow Metadata Lineage with
Metadata Browser.
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Flag

Batch Run ID

Indication

The message “Completed
MDR_METADATA Data Flow” indicates
that the Metadata Lineage parsing is
complete.

P_REPORT_FLAG

REPORT_ELEMENTS_OFS_RE
G_REP_EBA

Processes Dashboard Elements from
FSI_M_CELL_DIM_VAL and
FSI_M_CELL_DEFN.

The message “Completed
REPORT_ELEMENTS for
OFS_REG_REP_EBA’ indicates that the
Dashboard Metadata parsing is complete.

P_REPORT_FLAG

REPORT_TO_TARGET _MAP_O
FS_REG_REP_EBA

Processes Dashboard with Processed
Business Metadata.

The message “Completed
REPORT_TO_TARGET_MAP for
OFS_REG_REP_EBA” indicates that the
Dashboard to Business Metadata parsing
is complete.

P_REPORT_FLAG

REPORT_TO_SOURCE_MAP_O
FS_REG_REP_EBA

Processes Dashboard with Processed
MDR Lineage.

The message “Completed
REPORT_TO_SOURCE_MAP for
OFS_REG_REP_EBA” indicates that the
Dashboard to Data Flow Metadata parsing
is complete.

P_REPORT_FLAG

POP_FINAL_ELEMENTS_OFS_
REG_REP_EBA

Processes Final Data Elements for EBA.

The message “Completed
POP_FINAL_ELEMENTS for
OFS_REG_REP_EBA’ indicates that all
the Dashboard related Metadata parsing is

complete.

P_MDR_USAGE_FLAG

DATA_FLOW_USAGE

Processes Data Flow Usage.

The message “Completed Elements for
DATA FLOW_USAGE” indicates that the
Data Flow Usage Metadata parsing is
complete.
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Flag Batch Run ID Indication

P_MDR_USAGE_FLAG ULTIMATE_DATA_FLOW_USAG | Calculates Ultimate Table/Column Usage
E for Data Flow Metadata.

The message “Completed
ULTIMATE_DATA_FLOW_USAGE”
indicates that the Data Flow Ultimate
Usage Metadata parsing is complete.

P_MDR_USAGE_FLAG POP_MDR_LINEAGE_METADAT | Links Data Flow Usage Lineage with
A Metadata Browser.

The message “Completed
MDR_METADATA Data Flow” indicates
that the Data Flow Usage MDB Metadata
parsing is complete.

P_MDR_MD_DF_FLAG METADATA_TO_DATAFLOW Processes Parsed Business Metadata
joined with Parsed Data Flow Metadata.
The message “Completed
METADATA_TO_DATAFLOW?” indicates

that the Business Metadata to Data Flow

Metadata parsing is complete.

6.1.2 Validating Lineage Outputs

In Atomic Schema, you must verify that data is present in the following tables and ensure that the
table is populated:

¢+ MDR_LINEAGE_METADATA
¢ FSI_DE_REPORT_SOURCE_DETL_MAP

¢ MDR_USAGE_METADATA (Optional, data is populated only if P_MDR_USAGE_FLAG
is enabled.)

¢ FSI_DE_METADATA_SOURCE_DETAILS (Optional, data is populated only if
P_MDR_MD_DF_FLAG is enabled.)

NOTE: Itis recommended that the following SQL statement must be executed in Config Schema, if this
INDEX is not created:
CREATE INDEX index_mdr_mod_parent_child
CREATE INDEX index_mdr_mod_parent_child
ON mdb_object_dependencies (parent_object_def_id,child_object_def id)
COMPUTE STATISTICS
/
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6.2 Create and Export Metadata Report Templates

Perform the following steps to create and export the Metadata Report Templates:

1. Navigate to Object Administration - Utilities > Metadata Report.

ORACLE Financial Services Analytical Applications

Applicalions  Object Administration | System Configuration & ldentity Management

Select Information Domain

Anaiytical Appiications Infrastrucure » Obyect Administration > Ubiibes > Metadata Report

FSDFINFO v nd Filter CGo & Claar L. Refresh

4 @Fina pical Appications Inkrastructura M ]
4o
'8 Tomplate List (1) 14 Ada
» JWow Tempiate D ¥ Temptale Harme Tenpiane Description Created Dafo Croated By
» @1 O 2234m sample: 04.01-2017 OFSAD
<[ >

4 Sl

B motadata Difforonce

8 Motadata Authorization
@ Metadata Repart

b Save Metadata

T e Protectad Batch

o Component Regist

& Transfer Document Cwnershi
(& Patch Infarmation
169 Metadata Browser

2. Click Add icon, in Summary screen, to create a new Metadata Report Template.

Financial Services Analytical Apy frasts > Objest > Utiliies > Metadata Report
» Search and Filter C Go ) Clear . Refresh
Template | | Tempiate | |
D Name
= Template List (1) [ Add
TemplatelD ¥ Template Name Template Description Created Date Created By
[ 223483 sample 04-01-2017 OFSAD
< ] >

3. Provide the Name and Description for the new template in Template Definition page.

Template Definition

< Back L] Next >
Definition Choose Object type Filter Objects Review
Definition
Basic Details
Name ND[Test X

Description Tester

@ Save ¥ Return
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4. Select the desired object from the Object Type dropdown to be exported.

Individual report generates only the basic properties of the object selected, that is, name and
description. Relational report generates detailed information up to the Entities level, if
Dependencies is chosen; and up to the Staging Columns level, if Data Lineage is selected along
with Dependencies.

Dependencies: Metadata object is dependent on several other metadata objects. Metadata
object is also used (that is, consumed) in several other metadata objects. Dependency or usage
tree can be of any depth. For example, a rule can be dependent on a hierarchy, business
processor, and dataset. Further, each of these metadata objects can be dependent on other
metadata objects. Metadata Export Utility exports all the dependent or used metadata objects for
all paths in the dependency or usage tree, if this option is selected.

Lineage: Data is loaded from source systems to staging and then moved across to processing /
reporting. Lineage traces the data element as it moves across different layers of OFSAA: staging,
processing, and reporting. Metadata Export Utility exports the lineage of each of the reporting
area data element that is identified by dependencies.

For Individual: In the Export Options, do not select Dependencies or Data Lineage.

Financial Services Analytical Application: ture > Object Administration > Utilites > Metadata Report
Template Definition
< Back O L4 % Next >
Definition Choose Object ty. Filter Objects
Choose Object type
Object Types
Choose  pashboard %
Export Options
Dependencies
Data Lineage
@ Save ¥ Return
The exported sample report for Individual is as follows:
A B c D -
1 |CLASSIFICATION_RULE_NAME CLASSIFICATION_RULE_DESC HIERARCHY_NAME HIERARCHY_DESC
2 |Reg Lig Cashflow - Outflow Others Total Collateral Reg Liq Cashflow - Outflow Others Total Collateral Risk Scenario Dimension Risk Scenario Dimension
3 |Reg Lig Cashflow - Outflow Others Total Collateral [Reg Liq Cashflow - Outflow Others Total Collateral Reg Liq Cashflow Group Reg Liq Cashflow Group
4 |Reg Lig Cashflow - Outflow Others Loss of Rights - Placed  Reg Lig Cashflow - Outflow Others Loss of Rights - Placed  Reg Lig Cashflow Group Reg Liq Cashflow Group
5 |Reg Lig Cashflow - Outflow Others Loss of Rights - Placed  Reg Liq Cashflow - Outflow Others Loss of Rights - Placed  Risk Scenario Dimension Risk Scenario Dimension
6
7
8
9
Classification Rule Hierarchy | Dataset O] 4 >
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For Relational: In the Export Options, select Dependencies.

Financial Services Analytical Applicat Infrastr re > Object Admini: > Utilities > Metadata Report
Template Definition
< Back O L4 o Next >
Definition Choose Object ty... Filter Objects
Choose Object type
Object Types
Choose | pashboard X
Export Options
Dependencies Cl
Data Lineage
@ Save ¥ Remn
The exported sample report for Relational is as follows:
A B C D E F G H J K L M N -
1 |Path Name Dependency
2 |Pathl Dashboard > Report > View > Hierarchy > Entities >
3 |Path2 Dashboard > Report > View > Derived Entity > Measure > Entities >
4 |Path3 Dashboard > Report > View > Derived Entity > Hierarchy > Entities >
5 |Path4 Dashboard >Report > View > Derived Entity > Dataset > Entities >
6 |Paths Dashboard >Report > View > Reporting Line ltem >Measure > Entities >
7 |Pathg Dashboard >Report > View > Reporting Line Item > Hierarchy > Entities >
8 |Path7 Dashboard >Report > View > Reporting Line Item > Derived Entity > Measure > Entities >
9 |Pathg Dashboard > Report > View > Reporting Line Item > Derived Entity > Hierarchy > Entities »
10 |Paths Dashboard > Report » View > Reporting Line Item > Derived Entity > Dataset > Entities >
11
12
3 Paths | Pathl Path2 Path3 Path4 Paths Pathé Path7? Pathg P.. @ 4 3

The first sheet shows the different Paths and their Dependencies up to the Entities level. Select
the required Path sheet at the bottom to view the dependencies.

Each path tells how the dependency/usage is derived from dashboard to entity or vice versa
involving various OFSAA object types like Derived Entity, Hierarchies, Datasets, Measures, and
S0 on.

These paths are generated by the system using data already published in MDB dependency
tables as part of OFSAA MDB object publish.

For every dependent object type displayed in each path sheet, the following columns are
displayed:

¢+ Object type name

¢+ Object type description

¢+ One or many Object specific properties (optional)
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For example: In Pathl, Dashboard is the first Object type, the dependencies generated are
Dashboard Name, Dashboard Description, and Dashboard properties: Dashboard Country,
Dashboard Regulator and so on. Similarly, Report is the next Object type in Pathl and the
dependencies generated are Report Name, Report Description, Views Name, Views Description,
View Display Format and so on. Then followed by Hierarchy Objects name, description and
properties up to the Entities level.

A B C D E F -

1 |DASHBOARD NAME -DASHBOARDiDESC DASHBOARD_COUNTRY DASHBOARD_REGULATOR DASHBOARD_FREQUENCY REPORT_NAME |
2 Floa Breakdown of financial assets by instrument and by counterp: European Banking Authority  Quarterly FI0401 |
3 Floa Breakdown of financial assets by instrument and by counterp: European Banking Authority  Quarterly FI0403
4 Floa Breakdown of financial assets by instrument and by counterp: European Banking Authority  Quarterly Fl0403
5 |Floa Breakdown of financial assets by instrument and by counterp: European Banking Authority  Quarterly Fl0403
6 |Floa Breakdown of financial assets by instrument and by counterp: European Banking Authority  Quarterly Fl0401 |
7 Floa Breakdown of financial assets by instrument and by counterp: European Banking Authority  Quarterly FI0405
3 |Floa Breakdown of financial assets by instrument and by counterp: European Banking Authority  Quarterly FI0402 |
9 |Floa Breakdown of financial assets by instrument and by counterp: European Banking Authority  Quarterly Fl0403
10 |Flo4 Breakdown of financial assets by instrument and by counterp: European Banking Authority  Quarterly Fl0402 |
11 |Floa Breakdown of financial assets by instrument and by counterp: European Banking Authority  Quarterly FI0405
12 Floa Breakdown of financial assets by instrument and by counterp: European Banking Authority  Quarterly FI0405 !
13 [FI04 Breakdown of financial assets by instrument and by counterp: European Banking Authority  Quarterly Fl0402 |
14 |Flo4 Breakdown of financial assets by instrument and by counterp: European Banking Authority  Quarterly Fl0402 |
15 |Floa Breakdown of financial assets by instrument and by counterp: European Banking Authority  Quarterly FI0405
16 |Fl0a Breakdown of financial assets by instrument and by counterp: European Banking Authority ~ Quarterly FI0401 |
17 [FI04 Breakdown of financial assets by instrument and by counterp: European Banking Authority  Quarterly Fl0403
18 |Flo4 Breakdown of financial assets by instrument and by counterp: European Banking Authority  Quarterly Fl0401 [fp=

3 Paths Pathl Path2 Path3 Path4 Paths Path Path7 Pathg P. (B 4 »

The Usage sample report (generated by default when Dependencies is selected) is as follows:

A B c D E F G H I J K
1 [Path Name lusage
2 |Path1 Columns > Hierarchy > View > Report »Dashboard >
3 |Path2 Columns > Measure = Derived Entity > View > Report >=Dashboard >
4 |Path3 Columns > Hierarchy = Derived Entity > View > Report =Dashboard =
5 |Pathd Columns > Measure = Business Processor > Derived Entity > View > Report =Dashboard = |
6 Patho Columns > Measure = Reporting Element > View > Reportt >Dashboard > 3
7 |Path6 Columns > Hierarchy > Reporting Element > View > Report »Dashboard =
8 Path? Columns > Measure = Derived Entity > Reporting Element > View > Report ~Dashboard >
9 |Pathg Columns > Hierarchy = Derived Entity > Reporting Element > View = Report >Dashboard »
10 |Pathd Columns > Measure > Business Processor > Derived Entity > Reporting Element > View > Report >Dashboard =
11 |Path10 Columns > Measure > Business Processor > Reporting Element > View = Report >Dashboard >
12
13
14
15 E
W 4« » ¥| paths ~Pathl . Path2 -~ Path3 .~ Path4 .~ Path5 -~ Patht . Path7 - Pathg . Path{ [l I 0

The first sheet shows the different Paths and their Usage up to the Dashboard level. Select the
required Path sheet at the bottom to view the Usage.
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[

D E
COLUMNS_PHYSICAL COL_ID  HIERARCHY_NAME HIERARCHY_DESC

A B
1 [COLUMNS NAWE IcoLuMNS_DESC
2 Transaction Account Flag Indicates if said account is conside FCT_DEPOSITS_BORROWINGS.F_Trans Account Flag Hierarchy  Hierarchy for Trans Account FlagBI
3 Repurchased Or Indemnified FlacIndicates if the said account is Rep FCT_LOAN_ACCOUNT_SUMMARY or Indemnified FlagR or Indemnified FlagBI
4 Impairment Amount Under Asc 3This column stores the impairment FCT_LOAN_ACCOUNT_SUMMARY. Impair a5c31030 Amount Check Impair asc31030 Amount Check BI
5 Troubled Debt Restructure Flag  This column indicates i said loan i FCT_LOAN_ACCOUNT_SUMMARY. Troubled Debt Restructure Flag Troubled Debt Restructure Flag Bl
6
7
8
9

Negative Amortization Flag  This column stores if loan has negz FCT_LOAN_ACCOUNT_SUMMARY. Negative lag Flag H\EraE\
Mortgage Broker Surrogate Key This stores unique identifier for the FCT_LOAN_ACCOUNT SUMMARY. Broker Skey Hierarchy Broker Skey Hierarchy
Cleared Transaction Flag This columns stores if particular tra FCT_REG_ACCOUNT_SUMMARY.F Cleared Transaction Flag Hierarc Cleared Transaction Flag H\ErartE\
Cleared Transaction Flag
10 Mark To Market Value In Report This stores the mark to market valu FCT_REG_ACCOUNT_SUMMARY. Itm Value-FRAS Hierarchy
11 Broker Surrogate key This stores unique identifier for the FCT_DEPOSITS_BORROWINGS.N_Broker Hierarchy Deposit Borowi Broker Hisrarchy Deposit Borowi BI
12 Callable Deposit Indicator Indicates if said deposit can be call FCT_DEPOSITS_BORROWINGS.F_ Deposit Option indicator Hierarct Deposit Option indicator Hierarct BI
13 Impairment Amount Under Asc 3This column stores the impairment FCT_ LOAN_ACCOUNT_SUMMARY. Impair asc31030 Amount Check Impair asc31030 Amount Check B
14 Troubled Debt Restructure Flag This column indicates if said loan is FCT LOAN_ACCOUNT_SUMMARY. Troubled Debt Restructure Flag FTroubled Debt Restructure Flag FBI
15 Troubled Debt Restructure Flag This column indicates if said loan is FCT_LOAN_ACCOUNT_SUMMARY. Troubled Debt Restructure Flag FTroubled Debt Restructure Flag FBI
16 Troubled Dbt Restructure Flag This column indicates i said loan i< FCT LOAN_ACCOUNT SUMMARY. Troubled Debt Restructure F\ag FTroubled Debt Restrueture Fiag FBI
17 Negative Amortization Flag  This column stores if loan has negz FCT_LOAN_ACCOUNT SUMMARY. Negative Flag Flag HieraBl
18  Cleared Transaction Flag This calumns stores i particular ra FCT_REG_ACCQUNT_SUMMARY F Clsared Transactien Flag Hisrere Cleared Transaction Flag Hierarc I
19 Mark To Market Value In Reporti This stores the mark to market valu FCT REG_ACCOUNT_SUMMARY .\ Mtm Value-FRAS Hierarchy  Hierarchy Mtm Value-FRAS  BI
20 Broker Surrogate key This stores unique identifier for the FCT_DEPOSITS_BORROWINGS.N_Broker Hierarchy Deposit Boroni Broker Hierarchy Deposit Borawi BI
21 Troubled Debt Restructure Flag  This column indicates if said loan is FCT_LOAN_ACCQUNT_SUMMARY. Troubled Debt Restructure Flag FTroubled Debt Restructure Flag HBI
22 Mortgage Broker Surrogate Key This stores unique identifier for the FCT LOAN_ACCOUNT_SUMMARY. Broker Skey Hierarchy Broker Skey Hierarchy Il
23 Mortgage Broker Surrogate Key This stores unique identifier for the FCT_ LOAN_ACCOUNT_SUMMARY. Broker Skey Hierarchy Broker Skey Hierarchy Bl
24 Claim Local Currency Code  Refers to the Local cumency code f FCT_REG_ACCOUNT_SUMMARY.V Currency Code Comparison Hier: Currency Code Comparison Hier:BI
25 Cross Border Claim indicator  Inicates if said claim is cross brod FCT_REG_ACCOUNT_SUMMARY_F Cross Border Claim Hierarchy  Cross Sorder Claim Hierarchy
26 Transaction Account Fla Indicates if said account is conside FCT_DEPOSITS_BORROWINGS.F_Trans Account Flag Hierarchy  Hierarchy for Trans Account FlagBI
27 Deposit Call Exercised Indicator This Column Stores the Deposit CaFCT DEPOSITS_BORROWINGS.F_ Next Option Flag Deposit Borrow Next Option Flag Deposit Borrow Bl
28 Troubled Debt Restructure Flag  This column indicates if sai loan is FCT_LOAN_ACCOUNT_SUMMARY Troubled Debt Restructure Flag FTroubled Debt Restructure Flag FBI
29 Troubled Debt Restructure Flag  This column indicates if said loan is FCT LOAN_ACCOUNT_SUMMARY. Troubled Debt Restructure Flag HTroubled Debt Restructure Flag FBI
30 Negative Amortization Flag  This column stores if loan has negz FCT_LOAN_ACCOUNT_SUMMARY. Negative Flag Flag HieraBI
31 Recourse to General Credit  This stores the recourse to general FCT_REG_ACCOUNT_SUMMARY.FRecourse To General Credit IndicRecourse To General Credit IndicBI
32 Contractual Maturity in Days  This column stores the orignal mati FCT_REG_ACCOUNT_SUMMARY_N Contractual Maturity Term Hierar Contractual Maturity Term Hierar BI
33 Nettable Pool Surrogate Key  This column stores the reference to FCT_REG_ACCOUNT_SUMMARY._ I Nettable Pool Surrogate Key Hie Nettable Pool Surrogate Key Hie BI
34 Broker Sumogate key This stores unique identifier for the FCT_DEPOSITS_BORROWINGS.N_Broker Hierarchy Deposit Borowi Broker Hisrarchy Deposit Borowi B
35 Broker Sumogate key This stores unique identifier for the FCT_DEPOSITS_BORROWINGS.N_Broker Hierarchy Deposit Borowi Broker Hierarchy Deposit Borowi BI
36 Deposit Call Exercised Indicator This Column Stores the Deposit Ca FCT_DEPOSITS_BORROWINGS.F_Next Option Flag Deposit Borrow Next Option Flag Deposit Barrow BI
37 Deposit Listing Senice Provdsr This Column Stores the unique ider FCT DEPOSITS BORROWINGS N Deposit List Skey Hierarchy

This columns stores if particular tra FCT_REG_ACCOUNT_SUMMARY F Cleared Transaction Flag Hierarc Cleared Transaction Flag Hierarc Bl
Hierarchy Mtm Value-FRAS ~ BI

Deposit List Skey Hierarchy 1

AV Paths | 'Pathi Patha | Path3  Bathd L aths L Paii . Pathy - bachd - Pathd. - PathiD L i i

F G H

HIER_TYPE HIER_MULTI_DIM_PROPERTY HIER_TOTAL_REQD
REGULAR Yes
REGULAR Yes
REGULAR Yes
REGULAR Yes
REGULAR Yes
REGULAR Yes
REGULAR Yes
REGULAR Yes
REGULAR Yes
REGULAR Yes
REGULAR Yes
REGULAR Yes
REGULAR Yes
REGULAR Yes
REGULAR Yes
REGULAR Yes
REGULAR Yes
REGULAR Yes
REGULAR Yes
REGULAR Yes
REGULAR Yes
REGULAR Yes
REGULAR Yes
REGULAR Yes
REGULAR Yes
REGULAR Yes
REGULAR Yes
REGULAR Yes
REGULAR Yes
REGULAR Yes
REGULAR Yes
REGULAR Yes
REGULAR Yes
REGULAR Yes
REGULAR Yes
REGULAR Yes
m |

Select Data Lineage in Template Definition - Choose Object Type to export the lineage

details up to the Staging Columns level.

NOTE: Data Lineage can be selected only if Dependencies is opted.

es Analytical Applications Infrastructure > Object Administration > Utilities > Metadata Report

Financial Se

Template Definition
< Back (@) [ ] @]
Definition Choose Object ty Filter Objects
Choose Object type
Object Types
Choose

Dashboard x

Export Options

Dependencies C}
Data Lineage CJ

& Save

¥ Return

Next »

NOTE:

Data Lineage is generated as a separate sheet in the generated Relational report along

with the Dependencies. Select the Lineage sheet to view the Data Lineage (up to

Staging column level).
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A B C D

1 |REPORT SCHEDULE VIEW CELLID

2 |FI04 Flo404 FI04-F10404 FID404R200C050
3 |Floa Fl0403 FI04-FI0403 FIO403R170C010
4 |Flo4 Flo404 Fl04-F10404 FID404R170C020
5 |Floa Fl0404 FID4-FI0404 FI0404R030C050
6 |Fl04 Flo402 Fl04-F10402 FIO402R180C010
7 |Floa Fl0404 FID4-FI0404 FI0404R120C040
3 |Fl04 Flo404 Fl04-F10404 FID404R020C050
9 |Floa Fl0403 FI04-F10403 DATASET_JOINS
10 |FI04 Flo401 Fl04-FI0401 FIO401R170C020
11 Floa Flo404 FID4-FI0404 FI0404R260C020
12 |FI04 Flo404 FI04-F10404 FID404R220C010
13 |Floa Flo404 FID4-FI0404 FI0404R190C030
14 |FI04 Flo404 Fl04-F10404 FID404R160C020
15 |Floa Fl0403 FID4-FI0403 FI0403R150C020
16 |FI04 Flo404 FI04-F10404 FID404R060C040
17 |Floa Flo404 FID4-FI0404 FI0404R030C040
18 |FIoa F10404 FI04-F10404 FIO404R110C010

Lineage (:

E

DERIVED ENTITY CODE
MANDATORY_SOURCE_COLUMN
MANDATORY_TARGET_COLUMN
MANDATORY_TARGET_COLUMN
DERROO1

DERR501
MANDATORY_TARGET_COLUMN
MANDATORY_SOURCE_COLUMN
MANDATORY_SOURCE_COLUMN
DERR501

DERR501

DERR501

DERR502

DERR501

DERR501

DERR502

DERR502
MANDATORY_TARGET_COLUMN

E

METADATA CODE

MANDATORY_SOURCE_COLUMN

MANDATORY_TARGET_COLUMN

MANDATORY_TARGET_COLUMN

DSRRO01

DSRR501

MANDATORY_TARGET_COLUMN

MANDATORY_SOURCE_COLUMN

MANDATORY_SOURCE_COLUMN

DSRR501

DSRR501

DSRR501

DSRR502

DSRR501

DSRR501

DSRR502

DSRR502

MANDATORY_TARGET_COLUMN
4

G
RESULT AREA TABLE
Mandatory Source Column
FCT_COMMON_ACCOUNT_SUMMARY
FCT_COMMON_ACCOUNT_SUMMARY
FCT_REG_ACCOUNT_SUMMARY
FCT_REG_ACCOUNT_SUMMARY
FCT_COMMON_ACCOUNT_SUMMARY
Mandatory Source Column
Mandatary Source Column
FCT_REG_ACCOUNT_SUMMARY
FCT_REG_ACCOUNT_SUMMARY
FCT_REG_ACCOUNT_SUMMARY
FCT_REG_ACCOUNT_SUMMARY
FCT_REG_ACCOUNT_SUMMARY
FCT_REG_ACCOUNT_SUMMARY
FCT_REG_ACCOUNT_SUMMARY
FCT_REG_ACCOUNT_SUMMARY
FCT_REG_ACCOUNT_SUMMARY

H
RESULT AREA COLUMN
MANDATORY_SOURCE_COL
N_MIS_DATE_SKEY
N_MIS_DATE_SKEY
N_REG_PROD_TYPE_SKEY
N_STANDARD_PARTY_TYPE
N_ACCT_SKEY
MANDATORY_SOURCE_COL
MANDATORY_SOURCE_COL
N_STANDARD_PARTY_TYPE
N_REG_PROD_TYPE_SKEY
N_STANDARD_PARTY TYPE
N_STANDARD_PARTY_TYPE
N_REG_PROD_TYPE_SKEY
N_REG_PROD_TYPE_SKEY
N_REG_PROD_TYPE_SKEY
N_REG_PROD_TYPE_SKEY
N_RUN_SKEY

5. Select Filter Objects to see the selected objects.

< Back

Financial Services Analytical Applications Infrastructure > Object Administration > Utilities > Metadata Report

Template Definition

O O
Definition

Choose Object type

[ ]
Filter Objects

Filter Objects

@ Save

Dashboard

¥ Return

Next >

Oracle Financial Services Software

80



OFS Regulatory Reporting for European Banking Authority (EBA) — Lombard Risk Integration Pack
User Guide, Release 8.0.5.0.0

>
6. Select one Filter Object from the Available Objects and Click to add a Selected Object.

<
Select one Selected Object from the Available Objects and click to remove a Filter
Object.

Dashboard

Available Objects

When the object list is huge, use the Search option as shown above. Type first three letters of the
Filter Object name and the relevant Filter Objects is displayed.

NOTE: You can type the complete Filter Object name to select and add to the Selected Objects.

Oracle Financial Services Software 81



OFS Regulatory Reporting for European Banking Authority (EBA) — Lombard Risk Integration Pack
User Guide, Release 8.0.5.0.0

Dashboard

Available Objects

7. Review the Template Definition once and click Save.

Template Definition
< Back o ) ) ® Next >
Definition Choose Objectt. . Filter Objects Review
Review
Object Identifier Object Name Object Type

] 1499240042983 Fl04 Dashboard

< >
Page 1 of1(1of1items) [1]

@ Save | 7 Retumn
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8. Click Return to go to the Summary page.

Financial Services Analytical Applicat Infrastructure > Object Administration > Ulilites > Metadafa Report
+ Search and Filter G Go < Clear 1) Refresh
Template

D

¢ Template List (2) [§Add @ Delete [ View . Edi - Download

223484 NDTest Tesler 05-01-2017 OFSAD
[ 223483 sample 04-01-2017 OFSAD

Template
Name

Template 1D - Template Name Template Description Created Date Created By

<

I >

9. Select a Template in the Template List in Summary screen and click Generate to export the
desired objects in Excel Sheet format.

NOTE: MDB Publish must be triggered before executing the Generate option.

10. The Report Generation function is an asynchronous action and to check the status of the export
function, use the Refresh option in Summary screen.

Financial Services Analytical Applicationsdatasicl Object Adminsstration > Utilities > Metadata Report

¥ Search and Filter © Go JCIearI"‘ Refresh I

= Template List (2) [§ Add

iate Name

Template ID Template Name

Template Description Created Date Crealed By Status
Tester 05-01-2017 OFSAD Not Started
04-01-2017 OFSAD Not Started

I [>

For Excel Export, the following are the Status values:

¢

Not Started: The Report Generation is yet to start, but the function has triggered the
action in the background.

Ongoing: The Report Generation is started and in process.

Completed: The Report Generation is completed and ready to view or download.
Failed/Partially Completed: The Report Generation encountered an issue and the
process is partially completed or failed.

NOTE: The export logs are generated and placed in the path

/Context_Name/logs/MDB.log.

Log files give the following information:

a) All Paths query

b) Query for each path and if data present for this path
c) Lineage query

d) Status of excel output creation

e) Exceptions and errors, if any
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11. Select a Template in the Template List in Summary screen and click Download to save a copy
of the generated Metadata Report Templates excel sheet, after the export status shows as

Financial Services Analytical Applications Infrastructure > Object Administration > Utlities > Metadata Report
# Search and Filter G Go o Clear 20, Refresh
Template Template
D Name
« Template List (2) [8Add (@ Delete [ View 2 Edit [&] Generatd
Template D ¥ Template Name Template Description Created Date Created By
223484 NDTest Tester 05-01-2017 OFSAD
O 2238 sample 04-01-2017 OFSAD
< >

User Access

The following user groups are pre-seeded in the component that helps user to get access to the
Metadata Report Extract screen.

¢ MDR View Group: Helps users to see Metadata Report Extract with View permissions.
¢ MDR Owner Group: Helps users to create templates in Metadata Report Extract.

6.3 View Metadata Report Templates

Perform the following steps to view the Metadata Report Templates:
1. Select a Template in the Template List in Summary screen.

2. Click View icon to view the generated Metadata Report Templates excel report (after the export
status shows as completed).

Financial Services Analytical Applicat Infrastructure > Object Administration > Utilities > Metadafa Report
= Search and Filter > Go < Clear 20} Refresh
Template Template
D Name

= Template List (2) (& Add @ Dele|< Edit [2¢] Generate %4 Download

Template 1D - Template Name Template Description Created Date Created By
M 223484 NDTest Tesler 05-01-2017 OFSAD
[0 223483 ‘sample 04-01-2017 OFSAD
< I >

NOTE: The Metadata Report Templates excel report is opened in view-only mode.

6.4 Modify/Edit Metadata Report Templates

Perform the following steps to edit or modify the Metadata Report Templates:
1. Select a Template in the Template List in Summary screen.

2. Click Edit icon to modify the generated Metadata Report Templates excel report (after the export
status shows as completed).

Financial Services Analytical Applicat Infrastructure > Object Administration > Utilities > Metadafa Report
+ Search and Filter G Go < Clear 1) Refresh
Template Template
D Name
= Template List (2) (& Add @ Delete [ View] ) Edit [§g] Generate 21 Download
Template 1D - Template Name Template Description Created Date Created By
M 223484 NDTest Tesler 05-01-2017 OFSAD
[0 223483 ‘sample 04-01-2017 OFSAD
< I >
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6.5 Delete Metadata Report Templates

Perform the following steps to delete the Metadata Report Templates:
1. Select a Template in the Template List in Summary screen.

2. Click Delete icon to delete the Metadata Report Templates.

Financial Serviges Analytical Applications

cture > Object Administration > Utllities > Metadata Report

¢ Search and Filter 5> Go  Clear Refresh
Template Template
D Name
v Template List (2) [@ Add |@ Delete |21 view 2 Edit [2] Generate .1 Download
TemplateID ¥ Template Name Template Description Created Date Created By
223484 NDTest Tester 05-01-2017 OFSAD
O 223483 sample 04-01-2017 OFSAD
<l
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7 Report Submission

This chapter provides an understanding of the report submission process. It includes:
¢+ Report Submission: AgileREPORTER to Regulator
¢+ Edit Checks/ Validity Check/ Quality Checks
¢+ Report Templates to be used in AgileREPORTER

7.1 Report Submission: AgileREPORTER to Regulator

After OFSAA has prepared and hands off the data as required to Lombard Risk, the subsequent activities
are performed within the AgileREPORTER.

Lombard takes care of the report format as per the regulatory requirement which may be eXtensible
Business Reporting Language (XBRL)/ XML/ Excel / .Data/ XML and so on.

7.2 Edit Checks/ Validity Check/ Quality Checks

The AgileREPORTER carries out the report level / submission check comprising Edit Checks / Validity
Checks / Quality Checks as provided by the regulator.

Note: Refer to the AgileREPORTER user documentation provided by Lombard Risk, for details of
activities within the AgileREPORTER.

7.3 Report Templates to be used in AgileREPORTER

The report templates to be used in AgileREPORTER are listed as follows:

Report / Schedule Name Report Template
CRSAOQO7A CRSA_v6
CRSA07B CRSA_v6
C1701C17001 OPRD_v2
C1701C17004 OPRD_v2
C1702C17002 OPRD_v2
C1703C17003 OPRD_v2
C27GRP LEXP_v4
C28GRP LEXP_v4
Cc29 LEXP_v4
C30GRP LEXP_v4
C31INDGP LEXP_v4
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ca1 LR_v4

C43AA LR v4

ca7 LR v4

C72 LCR_v1
C73 LCR vl
C74 LCR vl
C75 LCR vl
Fl0101 Fl01_v1
Fl0102 Fl01_v1
FI0103 FIO1 vl
Fl02 Fl02_v1
Flo3 FI03_v1
Fl0401 Flo4_v1
F10402 Fl04_v1
Fl0403 Fl04_v1
Fl0404 Flo4 vl
Fl0405 Fl04_v1
FI05 FI05_v1
FI06 FI06_v1
Fl07 FIO7_v2
Fl0801 FI08_v1
FI0802 FI08_v1
Fl0901 FI09_v1
FI0902 FI09_v1
FI10D1 FI10_v1
FI11D1 FI11_v1
FI1301 FI13_v1
F11302 FI13_v1
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FI1303 FI13_v1
Fl14D1 Fl14 v1
FI1601 FI16_v3
FI1602 FI16_v3
FI1603 FI16_v3
F11604 FI16_v3
FI1605 FI16_v3
FI1606 FI16_v3
FI1607 FI16_v3
FI1701 FI17 vl
FI1702 FI17 vl
FI1703 FI17 vl
FI18P1 FI18_v1
FI18P2 FI18_v1
F11901 FI19 vl
FI20 FI20_v2
F12001 FI20_v2
F12002 FI20_v2
FI2003 FI20_v2
F12004 FI20_v2
F12006 FI20_v2
F12007 FI20_v2
Fl21 Fl21_v1
F12201 Fl22_v1
F12202 Fl22_v1
FI3001 FI30_v1
FI3002 FI30_v1
FI3101 FI31 vl
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FI3102 FI31_v1
Fl4101 Fl41_v1
F14102 Fl41 vl
Fl4103 Fl41_vi
Fl42 Fl42_v1
Fl43 Fl43_v1
Fl4401 Fl44_v1
Fl4402 Fla4_v1
F14403 Fla4_v1
F14501 Fl45_v1
F14502 Fl45_v1
F14503 Fl45_v1
Fl46 Fl46_v2
LCR1 LCR_v1
LR LR_v4
LR4 LR_v4
SECA LEXP_v4
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7.4 Supported Report Template Version and Activation Date

The AgileREPORTER contains the details of the Report template version and the activation date of the
same. This can be accessed by selecting the Entity setup option in the Settings Menu which enables the
user to Add, Modify, and Delete Entities.

Lombard Risk | Dashboard [100]  XBRLChecker ~ hisys | 3% @
Entity Setup
Show Deleted Retums Delete Retun Log 9 Create New {5 import adjustments ~ Export To Regulator Format nE
Form Variables
Reguiator WORKFLOW STATUS
ENTITY RETURNS ¢  VERSION ¢  REFERENCEDATE ¢ JOB STATUS UPDATE  APPROVAL EDITIONS ~ TRANSMISSION ~ MODIFIE Administration 4
EUENtty 01 FI01 1 06/3012016 R0 (3 Update  (0/1)NOT ATTESTED 08/097204 -
Entity -
it F102 o) Undate -
EUEniity 01 Fl02 1 06302016 ®C [ x] [+] (0M)NOT ATTESTED 07130120/ (]
EUEntty 01  FI04 1 06/30/2016 @0 [v]x] €2 Update  (0/1)NOT ATTESTED 0802720/ 3
Form
EUEntity 01 EI05 1 06/30/2016 0 (2 Undate  (0/1)NOT ATTESTED 07/30120{ ]
EUENtty 01 FI06 1 06/3012016 R0 (3 Update  (0/1)NOT ATTESTED 071317204 -
Available date =
EUEniity 01 FIO7 2 06302016 ®0 [v]x] s Update  (0/1)NOT ATTESTED 07130120} -
EUEntty 01  FI08 1 06/30/2016 @0 (2 Update  (0/1)NOT ATTESTED 07/3012017 200647 SYS -
EUEniy 01 Fl09 1 06302016 [r]e} (2 Update  (0/1)NOT ATTESTED 07/302017 182326 SYS &
EUENtty 01 FI10 1 06/3012016 R0 [v]x] (3 Update  (0/1)NOT ATTESTED 07/3012017 182437 SYS -
EUEniity 01 F11 1 06302016 ®0 s Undate  (0/1)NOT ATTESTED 07/302017 1829:13  SYS .
EUEntty 01 EN3 1 06/30/2016 @0 (2 Update  (0/1)NOT ATTESTED 07/3002017 200823 SYS -
EUEntity 01 Fl14 1 06/30/2016 0 [ x] (2 Undate  (0/1)NOT ATTESTED 07/30/2017 20010012 SYS. ]
EUENtty 01 FI16 3 06/3012016 R0 (3 Update  (0/1)NOT ATTESTED 07/3172017 10:55:45  SYS -
EUEntiy 01 Fl18 1 06/30/2016 ®0 €3 Update  (0/)NOT ATTESTED 07/30/2017 200158 SYS -
EUEnty 01 EN9 1 06/30/2016 @0 (2 Update  (0/1)NOT ATTESTED 07/3002017 200212 SYS -
1 100[]

Figure 35: AgileREPORTER Entity Setup 1

Click on a created Entity to access report templates according to version and the activation date, and
assign the necessary privileges as required.

Lombard Risk | Dashboard Job Manager

Entity and Return Administration Deleted

Entity Setup x Add new entity €

Figure 36: AgileREPORTER Entity Setup 2

Refer to the OFS AgileReporter Application User Guide for more details.
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8 Maintenance

This chapter provides an understanding of the maintenence process for the regulatory templates.

Changes to regulatory template is one of the most common and continuous activity. The following steps
help to assess the impact (You can replace the measure, dimension for existing data warehousing
configuration pack using the below process):

1. Choosing different execution as a final. After report verification, if requirement is to change the
execution, then you must visit Marking Run as Final section. After making these changes you
must refresh Derived Entities (Executing Batch to Resave Derived Entities). Then
AgileREPORTER also needs to retrieve returns so that revised data is reflected on
AgileREPORTER.

2. If Executing Batch to Resave Derived Entities is not working, you can look for Batch Operation
Log files. For file path, refer to OFS Analytical Applications Infrastructure Installation Manual in
OHC documentation library and search for ficdb/log.

3. To apply revised patch, refer to the ReadMe file for instructions to be followed.

4. To update revised data warehouse configuration pack, perform the following instructions.

Lombard Risk | Dashbeard Job Manager 100 XBRL Checker v hisys | {¥ @
Show Deleted Returns Delete Return Log *) Create New Bl import adiustments - Export To Regulator Format Py Eq Users
Priviege Groups
Frrm WORKFLOW STATUS
ENTITY RETURNS ¢  VERSION ¢  REFERENCEDATE ¢ JOB STATUS UPDATE  APPROVAL EDITIONS ~ TRANSMISSION ~ MODIFIE User Groups
European Common Reporting v/ LU RAE
Calendar >
EUEntty 01  FlO1 1 06/30/2016 Q0 (2 Undate  (0/1)NOT ATTESTED 08097201 Form Schedule Binding L]
Entity - _
EUENtty 01 Fl02 1 06/3012016 Q0 [ x] (3 Undate  (01)NOT ATTESTED 07/30/20{ Galculation Engines ]
EUEnity 01  Fl04 1 0612012016 R0 [v]x] (a Update T ATTESTED 08/02/20| Config Package Binding -
Fom - Data Warehouse Integration
EUEMty 01  FIoS 1 0673022016 [r]e} (3 Update  (Q/1)NOT ATTESTED 0730120} = w
- . Setup Network File Location |,
EUEntty 01 FI08 1 06302016 Q0 (g Undate  (O/1)NOT ATTESTED  (O) I3 0731120 &
Available date - « Back
EUEnttyo1  FIO7 2 06302016 Q0 [vIx] (g Undate  (0/1)NOT ATTESTED  (O) 13 073020 ]
EUEntty 01 FI08 1 06302016 Q0 (3 Undate T ATTESTED 07302017 20:06:47  SYS &
EUEntty 01  FI03 1 0613012016 Q0 g Undate  (O)NOT ATTESTED  ( 07302017 182325 SYS 4
EUEnty01 10 1 063012016 Q0 [v]x] g Undate  (O/)NOT ATTESTED 07802017 182437 SYS H
EUEnty 01  Fl11 1 063012016 Q0 €3 Undate  (O/)NOT ATTESTED 07502017 182043 SVS H
EUEntty01 13 1 06302016 Q0 €3 Undate  (0/1)NOT ATTESTED 07302017 200823 SVS w
EUEnty01  FI14 1 06302016 Q0 [x] €3 Undate  (0/1)NOT ATTESTED 07302017 20:10:42 SYS -
EUEniy 01  EI16 3 06302016 Q0 3 Undate  (0/1)NOT ATTESTED 07312017 105645 SYS -
EUEniyo1 18 1 063012016 Q0 (3 Undate  (0/1)NOT ATTESTED 07302017 200158 SYS &
EUEniyo1  Fi18 1 063012016 Q0 (3 Undate  (0/1)NOT ATTESTED 0TR02017 200212 SYS &
1 100[v]

Name: It is the text that needs to be displayed in the contextual button.

URL Pattern: Replace <<OFSAA HOST>>, <<OFSAA PORT>> and
<<OFSAA CONTEXT>> with host, port and web context of the environment where OFSAA
is installed. Replace <<OFSAA HOST>> with the name of information domain.

Oracle Financial Services Software 91


http://docs.oracle.com/cd/E60058_01/homepage.htm

OFS Regulatory Reporting for European Banking Authority (EBA) — Lombard Risk Integration Pack
User Guide, Release 8.0.5.0.0

http://<<OFSAA HOST>>:<<OFSAA PORT>>/<<OFSAA CONTEXT>>/OFSAADrilldow
n/drilldownreport.jsp?cellid=${cellld}&infodom=<<INFODOM>>&legalentity=${entityCode}
&run=${run}&date=${referenceDate}

Example:
http://127.0.0.1:8080/ofsaa/OFSAADrilldown/drilldown.jsp?cellid=${cellld}&infodom=0OFS
FSDFINFO&legalentity=${entityCodel}&run=${run}&date=${referenceDate}

i. Use http or https depending on the protocol configured for OFSAA.
ii. Pick an icon.

iv. Click Add to save the details.

Lombard Risk | Dashboard Job Manager (1]  xBRLChecker -~ hisys %% @
Data Warehouse Integration @
OFSAA_EBA Contextual Buttons
EDIT NAME URL PATTERN DESCRIPTION ICON ¢
no Add Contextual Button x P 2
Add Name:
f
URL Fattern
Buittin Varizble:
= S{cellig} = S{entityCode} = S{entiyName} = SfformCode}
= = = = SiableCode}
= S{Y_ordinate} = 5{Z_ordinate} = squn}
Description
Pickan icon
&

Figure 38: Adding Contextual Button

5. After the data ware configuration pack is updated, Lombard Configuration pack must reflect this.

Note: Refer to AgileREPORTER user documentation for details.
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9 Troubleshooting Guidelines

This section covers troubleshooting guidelines for user of Oracle Financial Services Regulatory Reporting
Integration with AgileREPORTER, hereafter called as Integration.

Integration users provide the data inputs through the OFSDF where data is loaded, processed and results
are made available for reporting purposes. Integration package then makes this data available in required
formats to AgileREPORTER. In AgileREPORTER, this data is then aggregated according to the reporting
requirements and end users view this from AgileREPORTER User Interfaces designed for the Viewing /
Editing of this aggregated data.

This section provides detailed guidelines on how to troubleshoot the data issues tracing back the data
flow from AgileREPORTER.

9.1 Prerequisites

It is assumed that user can login and see following menus and respective reports in AgileREPORTER.

Lombard Risk Dashboard Job Manager 100 XBRL Checker  + hisys *x @
‘Show Deleted Retums Delete Retum Log %) Create New E§l import adjustments ~ Export To Regulator Format ) Exeort () Retrieve Retum

Regulator WORKFLOW STATUS

ENTITY RETURNS ¢  VERSION ¢  REFERENCEDATE ¢  JOBSTATUS UPDATE  APPROVAL EDITIONS ~ TRANSMISSION  MODIFIED ¢ MODIFIED BY ¢
European Common Reporiing ' 1Y A D

EUEnity 01 FI01 1 0673012015 Q0 (i Update  (0M)NOT ATTESTED 02/00/2017 145143 SYS -
Entity -
Fi02 61302016 O Update  (0/1) 1301 6 5
U Enity 01 o] EUEnity 01 1 0673012016 QC [x] [ {0/)NOT_ATTESTED 07/30/2017 20:08:46  SYS ]
EUEntity 01 FI04 1 0613012016 Q0 [v]x] €y Undate  (0M)NOT ATTESTED 08/0212017 17:0025  SYS -
Form
EUEniity 01 FI0S 1 06/30/2016 0 C# Undate  (0/1)NOT ATTESTED 073012017 182534 SYS -
EUEntity 01 FI06 1 067302016 Q0 (i Updste  (01)NOT ATTESTED 071312017 105421 SYS -
Available date -
EUEnity 01 FIO7 2 0673012016 Q0 [V]x] (i Update  (0M)NOT ATTESTED 0713012017 182635 SYS &
EUEnity 01 FI08 1 06/30/2016 Q0 (i Update  (0M)NOT ATTESTED 073012017 20:06:47  SYS -
EUEntity 01 FI09 1 06/30/2016 [r]e] i Untate  (0/1)NOT ATTESTED 073012017 182326 SYS -
EUEntty 01 Fl10 1 06/30/2016 R0 [v]x] (3 Update  (0/1)NOT ATTESTED 07/3012017 18:24:37  SYS -
EUEnity 01 Fli1 1 06/30/2016 [R]@] (y Update  (0/1)NOT ATTESTED 07/30/2017 1829113 SYS -
EUEnity 01 FI13 1 0673012016 Q0 (i Update  (0M)NOT ATTESTED 073012017 20:08:23  SYS -
EUEntity 01 Fl14 1 0673012016 [r]®] B €y Update  (0M)NOT ATTESTED 07302017 20:10:12  SYS -
EUEntity 01 EI16 3 06/30/2016 [r]e} i Untate  (0/1)NOT ATTESTED 07/312017 10:55:45  SYS -
EUEnty 01 Fi18 1 0672012016 ®0 €y Update  (0/)NOT ATTESTED 073012017 200158 SYS -
EUEniiy 01 FL19 1 0673012015 Q0 (i Update  (0M)NOT ATTESTED 0713012017 20:02:42  SYS -

1 100[v]

Figure 39: AgileREPORTER

This means configurations activities for the AgileREPORTER and OFSAA are completed. Set up activities
for Entity is done and reports templates as shown above are available for viewing. Report Names shown
in the figure are for illustration purpose and actual name depends on the integration pack licensed.

9.2 Troubleshooting Use Cases

9.2.1 Unable to Generate Report

If you are unable to generate reports, meaning none of the derived entities referred in the report has rows
for the LE/date combination, then you must refer to Installation Manuals of AgileREPORTER or OFSAA
Integration pack for further instructions and steps to be followed.

If the process mentioned in Installation Manual is correctly followed and still report list is not available
then you are requested to login the bug / service request with Lombard Risk.
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9.2.2 Data Unavailable in AgileREPORTER

This is a use case where you are logged in to AgileREPORTER, and selected particular regulatory report
for appropriate entity and As of Date, but unable to generate the report.

9.2.2.1 Fetching Null or Zero Values

AgileReporter is showing either Zero or Null values. It indicates that Derived Entities has data (however,
all required filer conditions are not matching and resulting in zero value output) or Derived Entity does not
have data at all.

Lombard Risk  LEXP v4 Eurcpean Common Reporting /425

[ER  Astowimpodlog - Adustnents  ~ ExpotToFile = ExpotToReguialorFornal | B3 Livelalidation B3 ValidateNow = Werkflow Ediions 06202017 16:28:10 %2 T O mstances 1
Snow Scale 4] p—
C 27.00 - Identification of the counterparty yie 1)
o
COUNTERPARTY IDENTIFICATION .
o
Residence of | ., e or he|  NACE Type of
C= pane == = counterpa code counterpart
counterparty Ly Pary
o010 020 030 040 060 070
+
aga
Page 8
Page 9
age 10
Page 11
Page 12
1
Lombard Risk  LEXP wvé European Common Reparting/ A25
[E]  Aswowimpetlop - Adustments - ExponToFile - EspodToReguiatorFormal  §Y LiveValidalion 53 VaidaleNow = Wordiow Ediions. 081202017 16:26:10 %2 v 4= wstences 1
- how Scale —
C 31.00 - Maturity buckets of the eXposures vv wiaviuuu wivase svivnn e e w
MATURITY BUCKETS OF THE EXPOSURE "
]
o
S e i Eriz (i Greater than | Greater than |Greater than NS Greater
than 11 | than 12 | than 15 | than 18 | than 21 than 33 Greater than|
24 months | 27 months | 30 months than 3 Greater than| Undefined Page 1
months up |months up| months | months up [menths up| Imoenths up) S years up .
uwpto27 | upto30 | upto33 years up to 10 years | maturity
ta 12 to 15 upto 18 to 21 to 24 Months Months Months to 36 G to 10 years Page 2
Months | Months | Months | Months | Months Months U ragen
140 150 160 170 180 190 200 210 220 230 240 250 260
i o 0 o 0 o o o f o 3| 3| 0 Fage s
2 o 0 9| 0 0 o o [ o 3 3| 0 —
2 o o o o o o o f o 3 A 0
4 o o o o o o o 3 o 3 A o Pages
: o o 7] 25,108, [ o o 3 o 3 o 0
® o 0 o 0 0 o o o 0 3| 0| 0 Page?
7 o 0 0 0 o o f o 3 A 0 —
: o o 0 o o o f o 3 A 0
s o Tom0 0 o o o 3 of 3| 3| o Pagey
0 o o o o o o 3 o 0 3 o
it o o o o o o n o 3 3| o Page 10
) o o o o o o 3 o 3| 3| o —
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Figure 41: Fetching Zero Values
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You must validate as:
1. Derived Entity has data:

a.

b.

Execute the Derived Entity / Materialized views to check if Derived Entity has data or
not.

If Derived Entity / materialized view has data but not showing in AgileREPORTER, you
must log a Bug / Service Request with Lombard Risk.

2. Derived Entity does not have data:

a.

Execute the Derived Entity / Materialized views to check if Derived Entity has data or
not.

If Derived Entity does not have data, then check the Business Metadata excel for a given
schedule.

Check Worksheet titled ‘Derived Entity’ in Business Metadata excel. Get all the derived
entities for a given schedule.

Get dataset for each derived entity.

Execute datasets in OFSAA FSDF Atomic Schema to check if data is available for a given
dataset joins.

If data is available in dataset queries, you must log a Bug / Service Request with
AgileREPORTER.

If data is not available in dataset, then check if selection of Entity, Available Date (as of
date) is appropriate and required executions are available. If Entity, As of Date and Run
executions are correct and still data is not available, then you must log a Bug / Service
Request with Oracle Support.

9.2.3 Data Available in AgileREPORTER but Not as Expected

This use case where you are able to refer data for a required cell of a schedule in AgileREPORTER,;
however, value shown differs from expected value.

Let us take following example to illustrate the steps to be followed. This refers to Schedule 4.1 from FI04
report of EBA. Particular cell referred here is FI0401R070C020:

060 Debt Securities:
070 Central banks
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Lombard Risk FI04 v1 European Common Reporting / EU Entity 01 06/30/2016 Not Attested (0r1) %

Ashowimpotlog - Adusimenis - ExporiToFlle - ExportToReguiatorFormat | Y LiveValdation = 53 ValidaleNow  ~ Workfow

Editions  07/31/2017 10:53:53 7 | Instances | 1 -

Show Scale [ x] —
a of financial assets by instrument and by ¢ S

4.1 Financial assets held for trading

References Accumulated changes in fair value due to credit risk

Carrying amount 0

Annex V.Part 2.46

010 |[Equity instruments 350,049 Table 4.2
020 fof which: at cost 137,821
030 of which: <redit institutions 12,778 Table 4.3 P1
040 fof which: other financial corporations 7.783
050 Jof which: non-financial corporations 133188 Table 43F2
050 |Debt securities 1,870,028 127,220 Table 4.4 P1
070 Central banks 218,958 7,480 e ddmn
080 General governments 369,748 34,359
090| Credit institutions 308,284 20672 Table 45
100 Other financial corporations 171918 9,111
10| non-financial corporations 801,119 §8.597
120|Loans and advances 1,162,606 97,808
130| Central banks 166,302 13,249
140| General governments 151304 14,448
150| Credit institutions 195 865 15,391
160| Other financial corporations 55,082 4736
170 on-financal corporations 473413 415609
180| Households 120639 8,376

Figure 42: Schedule 4.1 from FI04 Report

You can drill down for each cell to check details of data as what is included in aggregation. To drill down,
click the value of particular cell and it is shown highlighted. It shows OFSAA data lineage icon on clicking
as shown in Figure 43.

Lombard Risk FI04 v1 European Common Reporting / EU Entty 01 06/30/2016 Not Attested (0/1 x

A Show Import Log + Adjustments ~ ExportToFile  ~ Export ToReguiator Format g1 Live Validation &Y Validate Now + Workflow

Editions  07/11/2017 11:00:51 #1 L IC) Instances 1 -

Show Scale [x] .

Table 4.1

Table 4.2
Table 4.3 P1
Table 4.3 P2

Table 4.4 P4

7470751112

Table 4.4 P2
OFSAA
Table 45

Figure 43: Data Lineage OFSAA Icon

Make sure that you are logged in to OFSAA infrastructure before clicking Data Lineage icon.
¢ If you are not already logged in, clicking here opens the OFSAA infrastructure login window. Log
in using appropriate credentials and come back to Report Portal and click the same Data
Lineage icon again.
¢ If you are already logged in to OFSAA Infrastructure, the Data Lineage first page opens as shown
in Figure 44,
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Data Lineage

Run Execution It Date

Legal Entiy EU Entity 01 Reference igentifier

» Derived Entity : DE- IFRS Account Summary  (15) =]

N s N s
N s N TRLIADER
N s N TRLIADER

N 8 N TRLIADER
N B N TRLIADER

N s N TRLIADER

iredFlag | Seniority Flag | Over The Counter indicator  |Buyor Sellflag | Senior Claim Flag | instrument Contract indicator | Requlatory Credit Ststus Code | Irading Account Book Type Code | Hedae Type | Cumulative change in FV due to credit risk RCY.

441980388

26720816

Figure 44: AgileREPORTER Drill-down

Top block of this screen shows following information which helps to connect the AgileREPORTER

aggregated data to OFSAA references.

1. Run Execution ID: This refers to OFSAA Execution ID chosen for a given report.

Date: This refers to AS OF DATE selected for a given report.

2.
3. Legal Entity: This refers to the OFSAA Legal Entity for whom the report is generated.
4. Reference Identifier: This is the cell reference for which data drill down / lineage is being

checked.

Second block displays all hierarchies with values used in a given Derived Entity and measures

aggregated for a given combination of a hierarchy values.

To refer the measure values, scroll rightwards using horizontal scroll bar at bottom of second

block. On extreme right, measures are displayed as shown in Figure 45:

Data Lineage
Run Executon 1g Date

Legal Entiy EU Entity 01 Reference identifier

> Derived Entity ; DE- IFRS Account Summary  (15) i)

ired Flag | Seniority Flag | Over The Counter Indicator  |Buyor Sell Flag | Senior Claim Flag | Instrument Contract Indicator | Requlator tatus Code | Tradi 1t Book Type Code

N s N s
N s N TRLIADER
N s N TRLIADER

N 8 N TRLIADER
N 8 N TRLIADER

N s N TRLIADER

Hedge Type | Cumulative change in FV due to credit risk RCY.

441982288

267.298.16

Figure 45: Measure Values

Only measure values are hyperlinked indicating that they can be drilled down further. On
clicking the amount, second level drill down show the lowest granularity data available for a

given cell reference.
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9.2.3.1 Using Drill-down with Data Lineage View

Data Analysts/You can then compare these accounts and their respective monetary amounts with

expected values. One can check the following:
1. All required accounts are shown in aggregation

2. Unwanted accounts are not included in aggregation
3. Measures / Monetary amounts at account granularity are as expected.

Any deviation from expectations can be then checked back for:

1. If measure is stage pass through, then validate using T2T to verify if stage data is as expected or
must be corrected.

2. If measure is processed, then validate using T2T to verify processing measure is correctly moved
to result area.

3. Ifreclassified hierarchies are showing unexpected values, check Rules and source hierarchies of
rules. This use case needs close verification to ensure that all source hierarchies have required
values or Rule sequence which can lead to overwriting the values.

4. |If all the source data is as expected and result area is now showing unexpected output, then log
a Bug / Service Request with Oracle Support.

9.2.3.2 Data Lineage View is not available

If the second block does not show any data, then data analysts/you are advised to refer to the data set
worksheet of Business Metadata.

Data Lineage
Run Execution Id Date

Legal Entiy EU Entity 01 Reference Identifier

» Derived Entity : DE- IFRS Account Summary (0) i)

wedFlag | Seniority Flag | Over The CounterIndicator | Buy or SellFlag | Senior Claim Flag Contract Indicator | Requlatory Credit Status Code | Trading Account Book Type Code | Hedge Type | Cumulative change in FV due o credit risk RCY.

Figure 46: Data Lineage Unavailable

There can be few reasons why second block does not show the data:

1. Internet connection is timed out or broken down - in this case clicking Data Lineage on
AgileREPORTER results in a blank second block. To rectify this, re-login to OFSAA infrastructure
and AgileREPORTER.

2. Data Lineage view works after Metadata is published using OFSAA Infrastructure. To validate if
Metadata is properly published or not.

3. If Metadata is properly published and second block still does not show the data, then start with
Derived Entity code shown at the beginning of second block. This Derived Entity code is available
even if data is not available.

4. Using this Derived Entity code data analysts are advised to refer to OFSAA Business metadata
with worksheet name as ‘Derived Entity’. Sample Business Metadata excel is shown in Figure 47:
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1 Derived Entiy Code Short Deseription Long Description SourceType | Aggregst Materislised View Dataser Code Dataset fiame Selected Metadsta
120 Dere: Dataset v 0 DSRRO02
121
12|
125
124
125
126
127
125 DERRGO3 Dateset v O DSAR003
129
130
131
132
133
13
135
136 Name
137 Branch BSR Code
135 DERRo0s Dareser v O DSRRO0E 05~ Mana: [Reporting Line Code
139 Consolidation Code
140 Entity Country ID
141 Org Structure Entity Code
122 Calndar Date
143 Run Description
100 Eop Balance ACY
12 Movement RCY
14 Branch BSR Code
147 DERRGOS DE - Rez Account VT Matrics DE - Rez Account VT Matrics Dataset v O DERRO0S D5 Reg Account VT Matrics = o
128
129
Caendar Date
Run Desaription
Eop Interest amount REY
« Hierarchies-BI | Base Measures | Datasets | Derived Entity | BusinessProcess | Alias | DE-Sequence | FSAPPSSCRF .. (B k] 3

Figure 47: Business Metadata

By referring to Business Metadata, you can get complete information on Derived Entity such as

dataset, Fact tables, measures, hierarchies defined under particular Derived Entity.

Aggregat Materiaised View Dataset Code Dataset liame Selected Metadata Selected Metadata Cotle
v psaron2 HRROO
HRROO3
HRROOG
HIREGD0S
HIREGDOL
HIREGD02
HRROOS
MRROD2
v v DeRR003 HRR2021
HRROO%
HRROO3
3 HRROOS
32 HIREGD0Z
33 HIREGDOL
34 HIREGD0Z
35 MRROD2
3 c Name HRROIO
37 Granch 858 Code HRROOS
38 i ¥ DSRROGE D5 -Management Reporting MID Movement Reporting line Code HRROOZ
) Consoligation Code HRROO3
40 Entity Country 1D HRROOG
ot Ore Structure Entity Code HIREGD0Z
oo Calendar Date HIREGDOL
hes Run Deseription HIREGD02
m [Eop Balance FLY MRROOT
jies Movement ReY MRROD2
125 ranch B5R Code HRROOS
o7 Dataset ¥ ¥ DsRR00S D5~z Account 17D Metrics| Reguiatory Deposit Type Group Code HRROOT
m Regulatory Deposit Type Code HRRO34
heo Entity Country 1D HRROOG
) Org Structure Entity Coge HIREGO0S
jis1 Calendar Date HIREGDOL
his2 Run Description HIREGD02
jiss Eop MRRODS
o T 0 0 [RTS TR -Res Arrmunr (D i DamiiataniNanncit Tuna Crmn Cade —Tuconor
« Hierarchies-BI | Base Measures | Datasets | Derived Entity | Business Process | Alias | DE-Sequence | FSAPPSSCRF ... (&)

Figure 48: Business Metadata

The Dataset ANSI Joins provide valuable information on how various entities are joined/linked together.
By executing these Joins, you can confirm if data is available for given filters and conditions. If data is
fetched using Dataset Joins and Data Lineage does not show data, you must log a Bug / Service Request

with Oracle Support.
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